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CHAPTER 1: INSURANCE RETURNS

TOPICS COVERED

This guide describes the best insurance practices to use for setting up your returns, including information on
each data sourcing method, as well as selecting the appropriate entity and return types for completing your
insurance tax returns in the most efficient manner.

Having the correct entity setup and structure allows for the successful e-filing of a mixed group consolidated
return to the IRS and to state jurisdictions, as applicable.

Topics in this guide include:
« Working in the Tax Application

Selecting the Data Source

o Creating the Insurance Return

o Working with the 1120-L Tax Return
o Working in the 1120-PC Return

« Activating State Insurance Returns
o Net Operating Loss

« Consolidating the Insurance Return
o Mixed Group State Consolidation

o Printing the Return

GETTING STARTED

The first step in getting started with preparing your insurance tax return is determining how you want to enter
your information into the system.

THOMSON REUTERS
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2 Chapter 1: Insurance Returns

Getting Started

NAIC Annual Statement Transfer The most commonly used method for entering data into the tax return is
to import information from the NAIC (National Association of Insurance Commissioners) Annual Statement file,
which then automatically populates many of the tax return items. The bulk of the information needed to prepare
insurance income tax returns, for both Life returns and Property and Casualty returns, is contained in these
files.

Electronic Organizer Alternatively, data can be entered directly in the Electronic Organizer if an NAIC Annual
Statement was not prepared, or is not used (as in the case of offshore companies).
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CHAPTER 2: WORKING IN THE TAX
APPLICATION

CROSS-CHECKING OF DATA SOURCE TYPES

When you create the return and choose the data entry method, the insurance application then crosschecks the
return and entity type and gives you a warning of an invalid selection. For example, a company filing an 1120-L
can choose to populate the return through the Electronic Organizer, the Life Annual Statement Transfer, or the
Separate Accounts Annual Statement Transfer.

Below are the entity types and the return types available:

1120-L
o Life Annual Statement
o Separate Accounts Annual Statement

o Electronic Organizer — Data Entry

1120-PC

Property and Casualty Annual Statement

« Title Annual Statement

o Health Annual Statement

Electronic Organizer — Data Entry

1120

o Electronic Organizer — Data Entry

THOMSON REUTERS
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4 Chapter 2: Working in the Tax Application

Organizer and Tax Forms

ORGANIZER AND TAX FORMS

The Organizer is the central collection point for all data in a given tax year. The Organizer is initially populated

with balances, adjustments, and calculated amounts that flow from NAIC import, or are entered manually. The
Organizer also stores any supporting schedules and return data that are used to complete the tax return. The

primary type of screens found in the Organizer area are:

« Organizer These screens are used to display data or review the amounts that are imported or entered.
These screens have a gray background and white fields.

o« Workpapers These screens reside between the Tax Forms and Organizer screens, and show how
Organizer data is calculated for tax form completion. Workpaper screens are generally shaded with a
yellow background.

o Tax Forms These screens show on-screen reproductions of the tax forms. Tax Form screens have white
backgrounds.

GENERAL INFORMATION

The General Information folder contains data entry screens that allow you to make selections and customize
the return. This folder also contains options for print, compute, and schedules.

BASIC RETURN INFORMATION

Navigation: Organizer > General Information > Basic Return Information > Entity Information

The Entity Information screen displays the company Name, Entity Number, EIN, Address (or Foreign),
Dates, and has sections for the Return/Entity Type, Failed Life Return, and Business Activity
information. We recommend that you visually review and verify this information.

« Business Codes link: Select link to view a Help screen where another link exists to the IRS Business
Activity Codes.
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Chapter 2: Working in the Tax Application

General Information

« Entity Information: For the Electronic Organizer returns, enter the Name as desired that populates the
Tax Return. A check box is provided for Name changes. For Annual Statement returns, the name from
the Annual Statement is automatically filled in on both the federal and state the tax return. Enter the Entity
number in the field provided. The federal EIN is only needed for taxable entities, not divisions,
eliminations, or subconsolidation entities. A check box is provided if EIN is Applied for.

ENTITY INFORMATION

[[] Name change

[ Applied for

Figure 2:1

« Address: Address information is not required for the eliminations or the subgroup subconsolidation
return. For Annual Statement returns, the federal and state tax return automatically fills in the address that
is shown on the Annual Statement. Included are Address, City, State (drop-down list), and ZIP fields for
domestic addresses with a check box to indicate an Address Change. Foreign addresses include

Province, Country (drop-down list), and Postal Code.

ADDRESS

AAAress.......ooo

State..... | (NONE Selected) -

[] Address change

Foreign
AdAress.....o
Address (cont'd)............

Province.............
Country................ooo... (None selected) v

Postal code.............

Figure 2:2

THOMSON REUTERS
1120 INSURANCE GUIDE



Chapter 2: Working in the Tax Application

General Information

« Return/Entity Type: Select the return type, entity type, and data source.

RETURN / ENTITY TYPE

Returmn type........... | 1120-PC -
Entity type..........ooooiii e | Corporate single entity -
Datasource. .. Electronic Organizer -

Change return and entity types

View Federal Deactivation

Figure 2:3

« Failed Life Return: If the life annual statement is available, select the applicable check box to activate
1120-PC and/or deactivate 1120L.

FAILED LIFE RETURN

- If the life annual statement is available:

1 Select 1120-L as return type
2 Select 1120L - Life annual statement as data source
3 Check this box to activate the 1120-PC form ... . g

4 Check this box to deactivate the 1120L form................... O
- If the life annual statement is NOT available:

1 Select 1120-PC as return type
2 The data source should be default to electronic organizer after an entity type is selected

Figure 2:4

« Date of incorporation: The date is only needed for taxable entities, not divisions or elimination returns.
Select the Pre-1900 hyperlink if the date is before 1900. Enter the Month, Day, and Year of incorporation.

Do not enter dates after 1900 here.

DATES
Date incorporated.................................. MM/ DD/ YYYY Pre-1900
Fiscal year beginning_____________ MM/DD/¥YYY Transfer to Membersl

Fiscalyearending.............................. MM/ DD/ YYYY

Figure 2:5
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Chapter 2: Working in the Tax Application

General Information

« Business Activity: Select the Business Codes link to look up the Business Activity Code and enter it in
the field provided. A check box indicates if the business in Inactive. Type in the Principal business
activity and the Product or service.

BUSINESS ACTIVITY

Principal businesscode.................................

[ Inactive
Principal business activity..............................__

Productorservice....................................

Figure 2:6
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8 Chapter 2: Working in the Tax Application

General Information

RETURN AND PRINT OPTIONS

One of the choices under the Basic Options tab is to enter the number of federal and state returns. You can
make selections to print or suppress reports and summaries and indicate the items printed on every page, on
the attachments, or on non-tax form items.

Navigation: Organizer > General information > Return and Print Options > Basic Options tab

Organizer Tax Forms Collapse All - Basic Options Pyg 1-5 Options Tax Form Options E-file Options Accrual Options

Mew Features
CLIENT INFORMATION
QuickTrack
QuickForm Clint Coode. oo e e (Madbiz_Trmma
Inclusion of Deferred Foreign Income
CLIENT NOTES
I* [ General Information

Basic Return Information

I Return and Print Options

¥ [ Questions HNUMBER OF COPIES
Faid PreparenER0 Infermation Total number of federsl returns to be pANtEd. ..o
Bank Information Total number of state returns to be printed...._.._.. s
¥ [ Tax Defauits
» [ 1120-L Options EVERY PAGE PRINT OPTIONS
¥ [ Failed Life Options
Corporation Mame and Federal ElM......e e svassssansssssensas @ Print 0 Suppress
» [ Federal E-file Extension
b [ Federal E-ile Locator number and AcCount NUMBE........ oo @ Print O Suppress
* [ Deferred Acquisition Costs WEMSION MUMBET. e e e eemecanns & Print O Suppress
* [ Life Electronic Organizer Dete
L= S @ Print o SUPpI'E‘SS
b [ Amended Retumn
LS
* [ Income and Deductions ® Print Q Suppress
b [ Gains and Losses POOE AUMBRE o @ P () Suppress
» [ Taxes "
L L U @® Print o] Suppress
» [ Credits
* [ Payments and Extension
» [ Estimates and Penalties L IETS

b - -
[0 Letters and Filing Instructions Statement number printing on the forms. ... ® Print Os
rin uppress

» [ Informational Forms

Entire "See Statement” text printing on the forms.......ooo & Print

» [ Foreign Information O Suppress

(] Carryovers, Footnotes, and Invoicing Al white paper statements with the fase retum. @® Frint 0 Suppress

* [ Federsl Tax Elections o )
Statement numbers printing on the white paper statements....._....._... @® Brint ) Suporess
* [ States o

» [ State Intangible Selected federal forms attached to the state returns ..o

& Print Q Suppress
» [ Cities
HNON-TAX FORM OPTIONS

O Print ® Suppress

Figure 2:7
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Chapter 2: Working in the Tax Application

General Information

TAX FORM OPTIONS
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10 Chapter 2: Working in the Tax Application

General Information

This page shows calculation options for Schedules D, M-1, M-3, PN, and N.
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Chapter 2: Working in the Tax Application

General Information

There are also some form calculation check boxes for some forms such as Forms 1118, 1120-W, 1138, 1139,
2220, 4466, and 4562. A check box is provided to print the return with override indicators at the bottom of the
form.

THOMSON REUTERS
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12 Chapter 2: Working in the Tax Application

General Information

Navigation: Organizer > General Information > Return and Print Options > Tax Form Options tab
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Chapter 2: Working in the Tax Application

Basic Options Pg 1-5 Options Tax Form Options E-file Options Accrual Options

SCHEDULE D

O carry Capital Loss to Page 1 {Applies to taxable entity types only, i.e Single or Top Consolidated)
[0 Automatically prorate capital gains and losses under Section 582

SCHEDULE M-1

[ Print Schedule M-1 when the Schedule M-3 is used

SCHEDULE M-3

Schedule M-2 Options

SCHEDULE N

[ Foree Print Schedule M
O Suppress printing of Schedule N {Complete)

SUPPRESS PRINTING OF DETAIL SUPPORTING SCHEDULES FOR:

O sehedule M - Question 3
O schedule M - Cuestion 8a

SCHEDULE PH

[ Print Schedule PH workshest

Suppress printing of detail supporting schedules for:

O interest O Capital gain

O rents O Cramership

O Royalties. O Dividend CRMTyOWEr
FORM 1118

O Carry Foreign Dividend Gross-up from Form 1118 to Schedules C and M-1

FORM 1120-W

O Print 1120-W, page 1in compressad format (Chverride)

O Print 1120-W, Scheduls &, pages 2 and 3 in compressed format [Owverride)
125-A

COGS Oplions

General Information

THOMSON REUTERS
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14 Chapter 2: Working in the Tax Application

General Information

Figure 2:8

Basic Options Pg 1-5 Options Tax Form Options | E-file Options Accrual Options
L1 Suppiess T S0 USRS 10 o

O Suppress print of Form 1138 with Federal Return
FORM 2220

PRINT SEQUENCE .
[0 Use the 2220 seasonslized method

® Printin proper sequence [ Use the 2220 annualized method

O Print out of IRS Sequence

[ Print 2220, pages 1 and 2 in compressed format (Cwemide)
[ Print 2220, Schedule A, pages 3 and 4 in compressed format (Override)

FORM 2435

O Suppress print of Form 2438, Copy A

FORM 4466

O compute Form 4458
O Suppress filing instructions for Form 4466
] Suppress Print of Form 4486

FORM 4582

COMPUTE OPTIONS

O Carry federal depreciation to all state returns including nonadopting state(s)
[0 Use SL table rates for tax preference computations on all ACRS assets

[0 Calculate MACRS SL as basis divided by remaining life

[ Compute book depreciation and amartization

[ Reduce bock basis for Section 178 expense and (TG

Mumber of years to project depreciation (1 -8 yrs available)......ceeecicnennn,

Mumber of months to compute deprecistion for short year returns (Owermide)

PRINT OPTIONS

PRINT DEPRECIATION DETAIL USING SUPPRESS WHITE-PAFER DETAIL FOR
8] white-paper categories O amT deprecizfion
® the order in which they are entered (O AGE depreciation

O Both AMT and AGE deprecistion detsil

[ Superess sll deprecistion detsil print ® none of the above

O Suppress 4582, Part V', Section B detail

Figure 2:9
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Basic Options Pg 1-5 Options Tax Form Options E-file Options Accrual Options
FUKM 8752

O Suppress printing of Form 8752

FORM 8810

[ Adjust deductions and losses carried to Form 1120, page 1

FORM 8842

[} Suppress printing of Form 8342

FORM 8903

2603

FORM E316-A

ae-A

DEPLETION

Suppress printing of detsil supporting schedules for:

[ Degletion property [0 1DC adjusted cumrent eamings adjustment
[ Net income from oil and gas schedule [ Depietion camyover schedule

[0 IDC tax preference schedule

RENTAL ACTIVITY SCHEDULE

[} Suppress printing of rental activity schedule

PASS THROUGH ACTIVITY SCHEDULE

O Suppress printing of pass through activity schedule

FORM T20X

1120

ALL FORMS

[ Print retum with override indicators

Figure 2:10

M-3 OPTIONS

Chapter 2: Working in the Tax Application 15

General Information

According to the M-3 rules from the IRS, the M-3 must be filed if the entity has $50 million or more in assets,
which is an increase from $10 million in 2016. If an M-3 is filed, then a Schedule N reconciliation is not required.

For additional M-3 rules and instructions, see www.irs.gov.

THOMSON REUTERS
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16 Chapter 2: Working in the Tax Application

General Information

There are various M-3 options for calculation, print, and suppression of amounts. Select the Schedule M-3
Options link to view the Schedule M-3 options shown below.

Sch M-3 Options Sch M-3, Part Il Sch M-3, Part Il Detail Sch M-3, Part Il Sch M-3, Part Ill Detail

GENERAL OPTIONS

[ Check to indicate dormant or inactive corporation

Note: If you check this box, we will not print Parts Il and Il of Sch M-3. We will include the name and
EIN of this entity in the list of inactive subsidiaries printed with the consolidated return.

[ Exclude items with no differences from Part 11, line 25 and Part IIl, line 38 and report those on Part 11, line 28
Note: If you select this option, we will identify items with no differences on Part |1, line 25 and Part Il
line 35 detail, exclude these items from the calculation and print of Part |, line 25 and Part 1,
line 38, and include these items in the calculation and print of Part 11, line 28 (Income and expense
items with no differences).

Transfer Option for Consolidated Returns

COMPUTE OPTIONS

OPTION TO COMPUTE SCHEDULE M-1 AND/OR SCHEDULE M-3

O Compute Sch M-1 only Note: Sch M-1 will not print if
O Compute Sch M-3 only Sch M-3 is completed

O Compute Sch M-1 or Sch M-3 based on the total assets at the end of tax year unless option to
force print Sch M-1is
® Compute both Sch M-1 and Sch M-3 (Default) selected from below

Transfer Option for Consolidated Returns

[ Calculate bookitax difference for capital loss and contributions on Sch M-3 of member of a consolidated
group

Transfer Option for Consolidated Returns

] Global M-3 Automatic Calculation Suppress Option See List
[] Carry Section 78 gross-up from Form 1118 as a permanent difference

[ Calculate bookitax difference for income statement gainfloss as temporary

[ Do not carry gainfloss from Sch D and Form 4797 as a permanent difference to Part II, lines 23b - 23f

Figure 2:11
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Chapter 2: Working in the Tax Application 17

General Information

Mixed Group 1120/L/PC Group Entity check box
The entity check boxes at the top of the Schedule M-3 tax form automatically populate for Mixed Group entities.

Navigation: Tax Forms > LNL PC Schedule M-3/Form 8916 > Page 1

Page1 Page 2
SCHEDULE M-3 Net Income (Loss) Reconciliation for U.S. Property and Casualty OMS No. 15450123
(Form 1120-PC) Insurance Companies With Total Assets of $10 Million or More
Depariment of th Trassury P Attach to Form 1120-PC. .
Intemnal Revenue Servics P Go to www.irs.gov/Ferm1120PC for instructions and the latest information.
Check applicable box(es). 1) Non-conselidated retum 2) Consolidated return {Form 1120-2C anly)
{3) |X| | Mixed 1120/L/PC group {4) 1 Dormant subsidiaries schedule attached
Mame of corporation (common parent, if consolidated refurn). Employer identification number

1

3

3
Financial Information and Net Income (Loss) Reconciliation (see instructions)
1a Did the corporation file SEC Form 10-K for its income statement period ending with or within this tax year?
'_Jr Yes. SKip lines 1b and 1c and complete lines 2a through 11 with respect to that SEC Form 10-K.
%, | No. Go to line 1b. See instructions if multiple non-tax-basis income statements are prepared
b Did the corporation prepare a certified audited non-tax-basis income statement for that period?
7] Yes. Skip line 1c and complete lines 2a through 11 with respect to that income statement.
No. Goto line 1c.
¢ Did the corporation prepare a non-tax-basis income statement for that period?
:_1 Yes. Complete lines 2a through 11 with respect to that income statement.
%.|No. Skip lines 2a through 3c and enter the corporation's net income (loss) per its books and records on line 4a.
2a Enter the income statement perod: Beginn__ 1 Endir _ 1
b Has the corporation’s income statement been restated for the income statement penod on line 2a”?
1| Yes. (If"Yes," attach an explanation and the amount of each item restated.)

=3

1| No.
¢ Has the corporation’s income statement been restated for any of the five income statement periods preceding the period on
2a?

Yes. (If "Yes," attach an explanation and the amount of each item restated.)

No.
ny of the corporation's voting common stock publicly traded?

Yes.

No. If "No," go to line 4a.
b Enter the symbol of the corporation’s primary U.S. publicly traded voting common stock . . . . . |:|
¢ Enter the nine-digit CUSIP number of the corporation's primary publicly traded voting

commonstock . . . . L e e e e e | 3 |

5
i 1]

3a

g [

4a Worldwide consolidated nst income (loss) from income statement source identified in Part I. line 1 | 4a | 77,997,525/,

Figure 2:12

Global M-3 Automatic Calculation Suppression Check box

There is an option to suppress the automatic calculation of the following items on the Schedule M-3 for 1120,
1120-PC and 1120-L for Annual Statement and Electronic users. If this check box is selected, the automatic
calculations listed are suppressed. However, if you enter amounts in the M-3 Organizer, the amounts flow to
the M-3 as overrides.

THOMSON REUTERS
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18 Chapter 2: Working in the Tax Application

General Information

Navigation: Organizer > Return and Print Options > Tax Form Options. Select the Schedule M-3 link .
On the resulting M-3 Sch Options tab screen, scroll down to the Compute Options section.

Select the See List link to view a list of suppressed items.

COMPUTE OPTIONS
[ Carry Federal Form 1120, Schedule L total ending assets and total ending liabilities to Part |, line 12a

OPTION TO COMPUTE SCHEDULE M-1 AND/OR SCHEDULE M-3

) Compute Sch M-1 only MNote: Sch M-1 will not print if
) Compute Sch M-3 only Sch M-3, part Il and

O Compute Sch M-1 or Sch M-3 based on the total assets at the end of tax year part lll are completed
unless option to force

® Compute both Sch M-1 and Sch M-3 (Default) print Sch M-1 is
selected from Print
Transfer Option for Consolidated Returns Options.

[ Calculate bookftax difference for capital loss and contributions on Sch M-3 of member of a consolidated
group

Transfer Option for Consolidated Returns

[ Global M-3 Automatic Calculation Suppress Option See List
O Carry Section 78 gross-up from Form 1118 as a permanent different

[ Calculate bookftax difference for income statement gainfloss as temporary

Transfer Option for Consolidated Returns
O Do not carry gainfloss from Sch D and Form 4797 as a permanent difference to Part I, lines 23b - 23f
OPTION TO CALCULATE BOOK/TAX DIFFERENCE FOR GAIN/LOSS FROM FORM 4797

) Suppress automatic calculation
O Calculate as temporary difference
@® Calculate as permanent difference (Default)

Transfer Option for Consclidated Returns

Figure 2:13

Select the check box to activate the Global M-3 Automatic Calculation Suppress Option.
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Chapter 2: Working in the Tax Application

Reviewing the Tax Return

Global M-3 Automatic Calculation Suppress COption

Note: Selecting this option suppresses the automatic calculation of following items on Sch M-3
Gross capital gains from Sch D, excluding amounts from flow-through entities (Part I, line 23b)

Gross capital losses from Sch D, excluding amounts from flow-through entities, abandonment
losses, and worthless stock losses (Part I, line 23¢)

Met gain/loss reported on Form 4797, excluding amounts from flow-through entities,
abandonment losses, and worthless stock losses (Part |, line 23d)

Abandonment losses (Part |, line 23e)

Worthless stock losses (Part Il line 23f)

Addback of credit for alcohol used as fuel

Addback of Biediesel and renewable diesel fuels credit
Recapture under Section 179 and 280F (Part 1, line 26)
Meals and entertainment (Part Il1, line 11)

Domestic production activities deduction (Part [, line 22)
Depreciation (Part lIl, line 31)

Employment credits wage reduction (Part 11, line 37)
Reduction in Research and Development expense by credit (Part 1, line 37)
Extraterntorial income exclusion (Part Il line 37)

Passive loss adjustment (Part [ll, line 37)

Figure 2:14

REVIEWING THE TAX RETURN

We provide different reconciliations to review your tax return amounts such as the comparison of the NAIC
Annual Statementincome to the taxable income and the reconciliation of the taxable income to the Schedule M-
3.

RECONCILIATIONS OF THE ANNUAL STATEMENT INCOME TO TAXABLE
INCOME

Worksheets in the Tax Summary reconcile the Annual Statement income to the taxable income. The Tax to A/S
Reconciliation, Income Reconciliation, and Income Tax Return Summary Worksheets helps you reconcile the
Annual Statementincome to the 1120-PC or 1120-L tax return income by displaying any reclassifications, tax
adjustments, and M-1 adjustments.

D‘ If you want this reconciliation to consolidate in an 1120-L or 1120-PC subgroup with Annual
- Statement returns and Electronic Organizer returns, you must enter amounts on this worksheet.

THOMSON REUTERS
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20 Chapter 2: Working in the Tax Application

Reviewing the Tax Return

Navigation: Tax Forms > Federal > 1120-L Corporate Income Tax Return > Tax Summary. Select one
of the following tabs:

o Taxto A/S Reconciliation
« Income Reconciliation
o Income Tax Return Summary

Summary Tax Comps

Reclass Summary

o Federal Tax Forms Summary

THOMSON REUTERS
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Chapter 2: Working in the Tax Application 21

Reviewing the Tax Return

1120-L Tax to A/S Reconciliation Screen

Tax to A/S Reconciliation Income Reconciliation Income Tax Return Summary Summg

Tax Return to Annual Statement Reconciliation

GROSS INVESTMENT INCOME RECONCILIATION

Total investment income per Schedule B
Total investment income per adjusted NAIC annual statement...................

Total tax to annual statement differences. ..

CAPITAL GAIN AND LOSS RECONCILIATION

Totals from NAIC annual statement........o e
Total gain or loss from Form 1120, Schedule Do
Total reconeiling iterms.

Total tax to annual statement differences. .

L I |

SCHEDULE F RESERVES RECONCILIATION

Beginning Ending
Total Reserves - Schedule F line 7. ...
Total reserves - per reconciliation.. ...

Difference. .

MAIC RESERVES RECONCILIATION PAGE 3 TO PAGE 4

Total change in rezerves per NAIC annual statementpage 3.
Total change in reserves per NAIC annual statementpage 4. ...

DI ErBICE . e

Figure 2:15
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22 Chapter 2: Working in the Tax Application

Reviewing the Tax Return

1120-L Income Reconciliation

Tax to A/S Reconciliation Income Reconciliation Income Tax Return Summary Summary Tax Comps

Reconciliation of NAIC Annual Statement Income to Taxable Income

Schedule N 1120-L, Page 1 Balance
remium Income 1 1
eServes - -
| tment |
nvestment Income 1 1
er Income 1 1
anefits 1 1
Other Deductions...........cocooe..
1 1
Specialltems..__.. .
1 1

Met Income.........oooo

Schedule N Reconciliation prints unless suppressed under General Information | 1120-L Options | Print Options.

Figure 2:16
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1120-L Income Tax Summary

Chapter 2: Working in the Tax Application

Reviewing the Tax Return

Tax to A/S Reconciliation Income Reconciliation | Income Tax Return Summary Summary Tax Comps. Federal Tax Forms Summary
Form prints ically unless supp under Income lax Return Summary Worksheet
Organizer | General Information | 1120-L Options | Print Options.
Book Statutory Adjust. NAIC Income Tax Adjustments  Income Tax Return
(Automatic)
1 Premiums and annuity considerations_... 415,789 Z 415,789 Z 415,789
2 Supplementary contracts with
life contingencies.............. 60,245 1 60,245 60,245
3 Net investment income....... 10,000 1 10, 000! 1 10,000
4 Amortization of interest maintenance
TESEIVE....coeoemeieeeraeems e eceee e ceseeesesceraes 1,254 1 1,254 1 1,254
5 Separate accounts net gain from....
i 1,200 1,800 1,200
operations, excluding unreal............ 1
6 Commissions and expenses on reins.. 2,800 1 2,800 2,800
T Reserve adjustment on reins. ceded...... 1,700 1 1,700 1,700
& Miscellaneous income:
8.1 Income from fees associated
. 1,600 1,600 1,600
will investment management........ " ’ '
8.2 Charges and fees for diposit-type.... 3,500 3,500 3,500
8.3 Aggregated write-ins misc income.... 1
9 Total (Items 1 t0 8.3)u.ur.cocerererrereeenreeen 498,788 498,788 498,788
10 Deathbenefits....._._._.__.. . 124,563 1 124,563 1 124,563
11 Matured endowments..................... 39,658 1 93,635 99, 658
12 Annuity benefits._____ 10,000 10,000 10,000
1
13 Benefits - disability, A H policies............. 4,000 4,000 4,000
1
14 Coupons, endowments and similar.....
benefits. 1,000 1 1,000 1,000
15 Surrender benefitsfund withdrawals.___ 54,782 54,782 54,782
1

Figure 2:17
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24 Chapter 2: Working in the Tax Application

Reviewing the Tax Return

1120-L Summary Tax Comps

Tax to A/S Reconciliation Income Reconciliation Income Tax Return Summary Summary Tax Comps.

Summary of 1120-L Tax Computations

§816 life insurance reserve percentage test amount.............

TAXABLE INCOME ON 1120-L, PAGE 1 TO SCHEDULE N RECONCILIATION

Total Schedule Nreclassed items. .
1
LTl - Pame 1, e 2 e 573,632

LICTI - Schedule N Reconciliation.................
1
D B B e 573,682

TAXABLE INCOME ON 1120-L, PAGE 1 TO SCHEDULE M-3 RECONCILIATION

Taxable income, page 1 line 20, before NOL and special deductions...................... 576, 686
Taxable income - Schedule M-3.

[ =0 =) [ = SN R SRR ENSER 576, 686

TAXABLE INCOME ON 1120-L, PAGE 1 TO INCOME TAX SUMMARY WORKSHEET

LICTI-Page 1, ine 24 573,682 1
Net gain (loss) from operations before tax - Income Tax Summary Worksheet. ... 202,786

DIEIBIMER. ..ot 370,288

CONSOLIDATED TAXABLE INCOME ON 1120-L, PAGE 1 TO CONSOLIDATED SCHEDULES

LICTI - Consolidated Page 1

LICTI - Consolidated Schedules. ...

Figure 2:18
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Reviewing the Tax Return

1120-L Reclass Summary

Tax to A/S Reconciliation Income Reconciliation Income Tax Return Summary Summary Tax Comps. Reclass Summary

Summary of Statutory Reclassed ltems

Totals
Premium IMEOMIE.. ...t s e e s s ere e
LTt =TSSR

IMvesStMENT INCOMIE. ...t

-l e e

L= a1 T OSSOSO

Benefits.

COther Deductions.

-l e e

Special BemS. .

Total INCOMIE. .o

Figure 2:19
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Reviewing the Tax Return

1120-L Federal Tax Forms Summary

Tax to A/S Raconciliation Income Reconciliation Income Tax Return Summary Summary Tax Comps. Reclass Summary Federal Tax Forms Summary

Summary of Federal Forms

SUMMARY AMOUNTS

1120-L, Tax Due. 214,148

Sch. D, Capital Gains and Losses.

851, Prep

1118, Total Foreign Tax Credit

o e e e

1120W, 1

1122, G lidation Consent.

1138, Extended Amount

1138, Tentative Refund

2220, Penalty. 4,50% 1
3468, Ir Credit
3800, General Business Credit. 1

4136, Gasoline Credit.

4255, Tax

4486, Applied for Refund of Overp it of Estil Tax

4562, Depreciafi X
4582, izati X
4626, Alternative Minimum Tax HONE
4797, Sales of Business Property. 1
5471, Summary

5472, Summary 1
5735, P ions Tax Credit X
5884, Jobs Credit.

B252, Ir Sales Income. 1
6478, Alcohol Fuel Credit.

BT65, Orphan Drug Credit.

B765, F Activities Credit.

6781, §1256 Contracts and Straddls 1

7004, ic E> ion of Time.

8810, Passive Activity Limitation:

8827, Credit for Prior Year Minimum Tam. ... cececceeees

Figure 2:20

Reconciliations of Taxable income to other Schedules

Certain worksheets in the Tax Summary reconcile the taxable income to other tax schedules. The 1120-PC
Taxable Income to Schedule M-1 and Taxable Income to Schedule M-3 Income worksheets, for example, show
the 1120-PC or 1120-L tax return income by displaying any reclassifications, tax adjustments, and M-1
adjustments.
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Reviewing the Tax Return

Navigation: Tax Forms > Federal > 1120-PC Corporate Income Tax Return > Tax Summary. Select

one of the following tabs:
o Income Tax Return Summary (similar to 1120L)
o Taxto A/S Reconciliation (similar to 1120L)
« Taxable Income Reconciliation (see below)

o Federal Tax Forms Summary (similar to 1120L)

1120-PC Taxable Income Reconciliation

Income Tax Return Summary Tax to A/S Reconciliation

Taxable Income Reconciliation

Federal Tax Summary and Reconciliation
TAXABLE INCOME ON 1120PC, PAGE 2 TO SCHEDULE M-1 RECONCILIATION

Taxable income before NOL and special deductions.. ...
Taxable income - Schedule M1, e

| = =T o= SRS

TAXABLE INCOME ON 1120PC, PAGE 2 TO SCHEDULE M-3 RECONCILIATION

Taxable income before NOL and special deductions... ..
Taxable income - Schedule M-3.. e

D EIENCE . e

BALANCE SHEET RECONCILIATION

Beginning
Total assets - Schedule L. 523,002,349 1
Total liabilities and owners equity - Schedule L........ 823,002,349 1

Difference. ... NOKNE

RETAINED EARMINGS RECONCILIATION

Retained earnings - ending unappropnated, Schedule L.
Retained earnings - ending unappropriated, Schedule M-2.___.____ .

DB

70,564, 694
1

53,731, 654
1

-10,833,000

70,564, 6394
1

79, 663,282
1

Ending

(=]
(=]
o

, 421,472 1

(=)
()
[&:)

, 431,472 1

HOHE

132,331,253
1
199, 662,707 1

-§7,331, 454
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Chapter 2:

Reviewing

Figure 2:21

Working in the Tax Application

the Tax Return

DIAGNOSTICS

The system provides diagnostics to help you determine inconsistencies, omissions, or override errors. To
review diagnostics, select View > Diagnostics, and then select the type.

Click on the Diagnostics to go to the input field
Check and save to Suppress Diagnostics

Al Uncleared  Suppressed
I~ O Typesie)
0 Typesie) o
[ Severe()
[ Informationsi{t) o
[ Ekectronic Fiing - Rejects(1)

Quantity: &

Taxable income per 1120-L, page 1 and Schedule N is out of balance

Reconciliation of Income before DRD and OLD, and Schedule M-3: Inceme on Form 1120-L, page one, line 20, does not equal the amount shown on Schedule V-3, Part I, line 30. column d. See Tax Forms, Federal, 1120-L Corporate Income Tax Return, Tax Summary, and click on the Summary
Tax Comps tab to review.

Of LIGTI with Income Tax Summary Worksheet: Form 1120-L, page 1, line 23, LICTI, does not feconcile with income on the Income Tax Return Summary. Go to Federal, 1120-L Gorporate Tax Retum, Tax Summary, Summary Tax Gomps to review. Organizer users can enter ams

¥ [ Jurisdictions(6)
] Federal(®)
[ State(®)
O city)

O Uneategorized(0)

o

[m]

(m]

for Sth N from the Income Reconciliation tab, driling down to In 1 of the yellow worksheet, and then drling-down to Organizer. Altematively, this schedule ¢an be suppressed from printing. Go to Organizer, General Information, Return & Print Options, Print Options, and check the appiicable box

Net 965 Tax Liability: Per the IRS, any taxpayer who is required to include amounts in income under section 965 in the tax year beginning in 2017 or the tax year beginning in 2018 must complete and altach Form 965 to its income tax refurn. Data entry in the 2018 retur is mandatory even if all
85 income was reported on the 2017 tax retum. Click/drill down on this diagnostic o automatically access "Organizer \ Inclusicn of Deferred Foreign Income.” On that sereen, you will find more details about this IRS requirement, a link to the 965 IRS instructions, 2 link to easily jump to the G65
organizer, and an option to indicate that the taxpayer has zefo 965 reporting fequirements for tax year 2017 of tax year 2018. HOW TO DISABLE THIS REJEGT: Either 1) mark the option that no 965 reporting requirements exist or 2) enter required 965 detail in organizer.

The Life Annual Statement s out of balance.:
Net 965 Tax Liability: Per the IRS, any taxpayer who is required to include amounts in income under section 955 in the tax year beginning in 2017 or the tax year beginning in 2018 must complete and attach Form 955 o its income tax refurn. Data entry in the 2018 retur is mandatory even if all

65 income was reported on the 2017 tax retum. Click/drill down on this diagnostic o automatically access "Organizer \ Inclusion of Deferred Foreign Income.” On that screen, you will find more details about this IRS requirement, a link to the 965 IRS instructions, 2 link to easily jump to the G65
organizer, and an option to indicate that the taxpayer has zefo 965 reporting fequirements for tax year 2017 of tax year 2018. HOW TO DISABLE THIS REJEGT: Either 1) mark the option that no 965 reporting requirements exist or 2) enter required 965 detail in organizer.

Figure 2:22

In the left pane, the tax application categorizes diagnostics into three types for Federal, States, and Cities
categories:

« Severe: Should be cleared before printing the return (for example, an out-of balance return).

« Informational: Shows special calculations and the effects of overrides (such as schedules matched to
line items of the return). It can also display print and tax return errors that should be addressed before
filing.

« E-file: Three types of e-file diagnostics must be cleared if the return is to be accepted by the IRS or the
state tax departmen

o Electronic Filing — Alerts.

o Electronic Filing — Rejects: Errors the tax application has detected that must be cleared to e-file.

o E-file XML Validation errors: Errors detected after creating the e-file. These must be cleared to
get a qualified return.

THOMSO

N REUTERS

1120 INSURANCE GUIDE




CHAPTER 3: SELECTING THE DATA
SOURCE

There are two data sources for your Insurance returns:

« Import data from an NAIC Annual Statement. (See NAIC Annual Statement (page 30).)

« Direct entry of data in the Electronic Organizer. (See Electronic Organizer (page 34).)

This selection is made when creating the return.

Create a Return

Account” Year™ Type* Client Code
2MKN v v 1120 v
Entity Name™ Return Type* Entity Type™
1120-PC, Property & Casualty w Single Entity -

Data Source™

| [v]

Electronic Organizer
Health Annual Statement
Property and Casualty Annual Statemer|

Title Annual Statement

Figure 3:1

The data source selection depends on the Return Type selected.

RETURN TYPE DATA SOURCES

1120-PC Electronic Organizer
« Health Annual Statement

« Property and Casualty Annual Statement
« Title Annual Statement

THOMSON REUTERS
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30 Chapter 3: Selecting the Data Source
NAIC Annual Statement

RETURN TYPE DATA SOURCES

o Electronic Organizer

o Life Statement
o Separate Accounts Annual Statement

NAIC ANNUAL STATEMENT

The bulk of the information needed to prepare insurance income tax returns (1120-L and 1120-PC) is found in
the National Association of Insurance Commissioners (NAIC) Annual Statement. NAIC determines the
standards for financial reporting for insurance companies. The Annual Statement information is stored in
designated NAIC files that are then filed with the regulatory state. Each file is identified by a standard name that
indicates the return type and the filing period to which it pertains, and each insurance company’s unique NAIC
number.

An import of the NAIC Annual Statement file populates the Annual Statement of the Organizer pages, which
then flows to the appropriate Tax Forms in the tax application. Not all data is transferred from the Annual
Statement, only the data that is needed for tax compliance calculations and print is imported into the Organizer.

To transfer the NAIC Annual Statement for the 1120-L or 1120-PC tax returns, choose the correct data source
type. The tax application allows the transfer of these types of Annual Statements:

« Life (1120-L)

Separate Accounts (1120-L)

Property and Casualty (1120-PC)

« Health (1120-PC)

Title (1120-PC)

NAIC ANNUAL STATEMENT TRANSFER

You can import NAIC data directly from their Annual Statement file to the appropriate place in the tax
application. However, only certain pages, and not the entire statement, are transferred into the Annual
Statement Organizer because the rest is not needed. If additional data is desired, the client can use the
Electronic Organizer to add this information.

THOMSON REUTERS
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NAIC Annual Statement

To transfer data:
1. Onthe Organizer tab, select NAIC Annual Statement Transfer.

2. Verify the path and filename, transfer format, and filing year are correct. You must be able to fit the entire
path, including the TXT extension inside the field provided.

3. Select Browse.
4. Browse to the import file, and select Open.
5. Select the Transfer Format drop-down box. This lists the available transfers.

6. Selectthe Year drop-down box. Prior years are available for life and separate account annual statements
and LRD transfers.

7. After verifying the information, select Transfer, and then select OK.

Data transferred into the Annual Statement pages from an NAIC statement flows automatically to the provided
yellow tax detail workpapers. Workpapers are used to show the calculations and how a particular numberin a
return was derived. You can print the workpapers with the federal return, or print them separately along with the
federal schedules that support the return. They are available for the preparer’s use and are intended to simplify
the review process, as well as provide an audit trail.
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NAIC Annual Statement

ANNUAL STATEMENT TRANSFER FOR SHORT YEAR RETURNS

Income statement items for the short year tax return period are automatically prorated based on the number of
days in the short year when compared to the total number of days in the tax year. In the example below, the
income statement amounts would be calculated as half of the full year transferred amounts. Balance sheet
items are not prorated.

Organizer Tax Forms Collapse All [] NAIC Annual Statement Transfer

New Features ~ DISKETTE INFORMATION
QuickForm

) . Path and Filename *
Inclusion of Deferred Foreign Income
Vi\NAIC, 2009%Booke\P&Ch\21177_07_P_2009_0 M 1.TXT Browse... |

» [ General Information

PC and LRD Combined

Transfer Format.................... v
» [ Federal E-file

» [ Insurance Consolidations
FILING PERIOD INFORMATION

NAIC Annual Statement Transfer

» O PC Electronic Organizer BB | 2018 v
N . .
[J Loss Reserve Discounting Days in Short Year (Default - Full Year)............
» [ Salvage and Subrogation
Total Number of Days in Year (Default is 360)............coooooooeooeeen. |2 00
» [ Deferred Acquisition Costs
» [ Amended Return 1 [ Retain Group Detail (for multiple disks only)
» O Income and Deductions
T fe
» [ Gains and Losses ransier |
» [0 Taxes
Figure 3:2

D/* The tax software supports Annual Statement transfers only. The import of quarterly statement files
- is not supported.

NAIC MAPPING TO THE TAX RETURN

Worksheets are available to identify mapping of the NAIC Annual statement to 1120-L and 1120-PC, and to
assist in the reconciliation and preparation of the tax return. There are two separate files available:

« Property and Casualty mapping (https://www.riahelp.com/html/2021/reports/ins_mapping/1120PC _
Property_and_Casualty Mapping.pdf)

« Life Annual Statement mapping. (https://www.riahelp.com/html/2021/reports/ins_mapping/1120L_Life
Annual_Statement_Mapping.pdf)

The files are updated annually to reflect the latest tax law changes.
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https://www.riahelp.com/html/2021/reports/ins_mapping/1120PC_Property_and_Casualty_Mapping.pdf
https://www.riahelp.com/html/2021/reports/ins_mapping/1120PC_Property_and_Casualty_Mapping.pdf
https://www.riahelp.com/html/2021/reports/ins_mapping/1120PC_Property_and_Casualty_Mapping.pdf
https://www.riahelp.com/html/2021/reports/ins_mapping/1120L_Life_Annual_Statement_Mapping.pdf
https://www.riahelp.com/html/2021/reports/ins_mapping/1120L_Life_Annual_Statement_Mapping.pdf
https://www.riahelp.com/html/2021/reports/ins_mapping/1120L_Life_Annual_Statement_Mapping.pdf
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NAIC Annual Statement

STATUTORY-TO-TAXADJUSTMENTS

Important differences between accrual and statutory accounting methods require special statutory-to-tax
adjustments that are made when preparing the federal and state tax returns. Adjustments are made
automatically when transferring the Annual Statement.

Statutory-to-tax adjustments are made to the statutory data of the transferred Annual Statement balances to
arrive at net taxable income for the federal return. These adjustments follow the same general philosophy as
those made to book income for a domestic corporation. The most common example is the adjustment made
when depreciation for financial reporting purposes differs from depreciation for tax purposes.

Other adjustments that must take place for the taxable income computation include:
o Tax-exemptinterest
o Change in due and accrued dividends
« Change in deferred and uncollected premiums
« Change in deposit type contracts
o Premium amortization
« Capital gains
« Elimination of change in loading
« Elimination of home office rent
o Elimination of NAIC amortization
o Elimination of NAIC depreciation
« Elimination of market discount accrual
« Difference in collected and earned real estate
« Interest on encumbrances
o Increase in loading on deferred & uncollected premiums

« Investment expenses.

THOMSON REUTERS
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Chapter 3: Selecting the Data Source

Electronic Organizer

ELECTRONIC ORGANIZER

If the insurance company is not required to file an Annual Statement, data can be entered directly into the 1120-
L or 1120-PC Electronic Organizer. The data source method selected should be Electronic Organizer, not
Annual Statement.

| D/* Data that is directly entered in the Annual Statement Organizer pages is not supported. All data

entry should be made in the 1120-L or 1120-PC Electronic Organizer.

SCHEDULE M-3

There are two ways to complete the data entry for Schedule M-3 in the Electronic Organizer. The first method,
DIF importfiles, is preferred because it saves you the most time.

DIF Import Files

DIF import files are used to import data for all three parts of Schedule M-3.
Part | of Schedule M-3 is used only for single company or top consolidated returns.

DIF import files are available for 1120-L, 1120-PC, and 1120 separate returns, including Part | for top
consolidations.

Use the Schedule M-3 DIF/KAT files located at this link
(https://www.riahelp.com/html/2021/guides/1120/2021_DIF_1120_Sch_M-3.zip) to import the data.
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Electronic Organizer

Data Entry

Entering Schedule M-3 data directly into the Electronic Organizer. Data can be directly entered in the M-3
Organizer fields. The navigation is:

« 1120L: Organizer > Life Electronic Organizer Page 7 > Schedule M-3

e 1120PC: Organizer > PC Electronic Organizer Page 8 > Schedule M-3.

Organizer Life Electronic Organizer Page 7 Schedule M-3 Schedule M-3 Sch M-3 Options
Organizer Tax Forms Collapse All[F] Sch M-3 Options Sch M-3, Part | Sch M-3, Part i Sch M-3, Part Il Detail

Sch M-3, Part 1l Sch M-3, Part Il Detail
» [ Deferred Acquisition Costs A

~ [ Life Electronic Organizer
“ [J Check to indicate dormant or inactive corporation

[ Page 1 Note: If you check this box, we will not print Parts Il and Il of Sch M-3. We will include the name and
EIN of this entity in the list of inactive subsidiaries printed with the consolidated return.

v

» [J Page?2

» [ Page 3 [ Check to indicate mixed 1120/L/PC group

» [ Page 4 Transfer Option for Consolidated Returns

» [ Page 5 O Complete Sch M-3 only for alternative disclosure purposes under Rev. Proc. 2004-45 for transactions
with a significant book-tax difference under Sec. 1.6011-4(b)(6)

» [ Page6

v [ Page? [[J Exclude items with no differences from Part 11, line 25 and Part Ill, line 40 and report those on Part I1, line 2

Note: If you select this option, we will identify items with no differences on Part Il line 25 and Part Il
Sch L - Assets and Liabilities line 40 detalil, exclude these items from the calculation and print of Part I, line 25 and Part Ill,
line 40, and include these items in the calculation and print of Part Il, line 28 (Income and expense

~ [3 schedule M-3 items with no differences)

Schedule M-3
Transfer Option for Consolidated Returns
» [3 General Dependency Attachment

Supplemental Attachment to M-3
[ Page 8 COMPUTE OPTIONS

-

Figure 3:3

STATUTORY-TO-TAXADJUSTMENTS

Because tax adjustment balances are entered directly into the Organizer, there are no statutory-to-tax
adjustments. Statutory tax adjustments are used for Annual Statement users only.

ADJUSTMENTS AND RECLASSES

Adjustments, which are made either automatically or entered directly in the Organizer while preparing the
return, are one-sided only. However, Reclasses are two-sided entities with both a debit and credit amount
entered. An example of a reclass adjustment occurs when an amount is included in Other Income when it
should have been included in Interest Expense.

You can reconcile a balanced return back to the statutory calculations through a summary of reclasses and tax
adjustments. This summary is an important part of the supporting documentation of the insurance return.
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Electronic Organizer

Navigation: Tax Forms > Federal > 1120-PC Corporate Income Tax Return > 1120-PC Pg 1-8 > 1120-

PC, Page 2tab

Select the link on line 13 to view the yellow detail.

Organizer Tax Forms Collapse All [5] Page1 Page 2 Page 3

~ [ Federal A Form 1120-PC (2013)

Page 4 Page5

Page 6 Page7

Page 8 Page 9

Page 2

Billing Statement

Taxable Income - Section 832 (see instructions)

1 Premiums earned (Schedule E ine 7). . . . . . . . . ... [ ‘ 311,236,531,
~ [ 1120.PC - US Corporation Inc Tax Return 2 Dividends and inclusions (Schedule C,INe 17). . . . vt v i i e e e e e 2 | 3.146,519,
Tax Summary (a) Interest received (b) Amortization of
premium
1120-PC US Corporate Income Tax Return
Schedule M-3 3a Interest (including tax-exempt interest) , 35,373,112 38,237,
b [0 Sch D/8949-Capital Gains and Losses - 5215, 840
b Interest exempt under section 103 . . . S22 250 1
Sch N - Foreign Operations of US Corp
Sch O - Consent Plan and Appertionment [
E Organizer users, follow this line 23's link to get to the organizer input field for all other income: 3d 26,319,375
Sch PH - Personal Holding Company Tax 8 30 Other income...._......_. R N 4 2,228,643,
c |
Sch UTP - Uncertain Tax Position Stmt 5 1
. . 6 4,376,232],
» [ Form T - Forest Activities Schedule ‘ 31 Other income recl; SIS —— 1 7
1
} [ 851 - Affiliation Schedules 32 Other income tax adjustments. ... 1 8 .
¥ [ 926 - US Prop. Transfer te Foreign Cor § |2 3
1 33 Total other income to schedule A, line 13, 2,358,102 0 1
» [ 965 - Inclusion of Deferred Foreign Inc 1 1 N
» [ 966 - Corp. Dissolution or Liquidatio T e e e ey =
) 13 Otherincome (attach statement) . . . . . . . .. . ... .t ittt et 13 2,358,102,
> [3970 - LIFO Election 14  Grossincome. Addlines 1through13 . . . . .. .. ... ...t 14 349,666,802
» [ 972 - Consent for Income Inclusion 15 Compensation of officers (attach statement) (see instructions) . . . . . .. ... ... ... .. 15 1
........................... 16 34,729,000
573 - Deduction for Consent Dividend 16 Salaries and wages (less employment credits) . e 1
17 Agency balances and bills receivable that became worthless during the taxvyear. . . . . .. .. 17 AL
982 - Reduction of Tax Attributes ';' B = 18 1.033,200,,
c 12,714,490
» [ 1118 - Foreign Tax Credit § 19 Taesandicenses. . Losk texempt 18 —
G |20a interest L =TSN pointerestexp. W 3 cEal | 20c 275,650
1120-W - Corporation Estimated Tax 8121 Charitable contribubions . . . . . o o\ 21 1

Figure 3:4
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Electronic Organizer

Select the link (blue turn-down arrow) in the Other Income field on the tax return.

6 Capital gain net income (attach Schedule D (Form 1120)). . . . .+ . o v vt o i i vt o e et [ 2,376,232,
7 Net gain or (loss) from Form 4797, Part Il line 17 (attach Form 4797) . . . . .. . ... . ... |7 1
8 Certain mutual fire or flood insurance company premiums (section 832(b)1D)) . .. ... .. 8 1
9 Income on account of special income and deduction accounts . . . . . . ... ... ... | 9 1
10 Income from protection against loss account (see instructions) . . . . . . ... .. .. ... .. 10 1
11 Mutual interinsurers or reciprocal underwriters - decrease in subscriber accounts . . . . . . . . 11 1
12 Income from a special loss discount account (attach Form 8316) 12
13 Otherincome (attach statement) . . . . . . . . .0ttt e e e 13 2,358,102, |
14 Grossincome. Addlines 1through13 . . . . . . . . . o it e 114 343, 666, 802
15 Compensation of officers (attach statement) (see instructions) . . . . . ... ... .. ... .. 15 1
16 Salaries and wages (less employmentcredits) . . . . . . . .. ..ol 16 34,723,000,
17 Agency balances and bills receivable that became worthless during the taxyear. . . . . .. .. 17 634,563,
BB REMIS . L L e e 18 1,033,200
S[19 Taxesandlicenses. . . . . .. . ... ittt e | 19 12,714, 490),
T 20a interest p 275, 830), b incetan ™ B 3 cBal B |20c 275,650
Figure 3:5
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Electronic Organizer

Scroll down to Other Income Reclassed Items or Other Income Tax Adjustments, which are shown on
the yellow detail image. Select the Other Income tab to view a screen where you can enter adjustments.

Miscellaneous Income Protection Against Loss Account Interest Income Other Income Reclass and Tax Adjustments

Other Income

Recoveries of agents’ balances previously charged off - TRC 35-248.. ...
Finance and service charges and mortgage division income - TRC 35-250.. ...
Fee-For-Services - TRC 35-252
Title XVIIl - Medical and Title XIX - Medicaid - TRC 35-254........oooooooic

Extraordinary items - TRC 358-256. ...
Risk Revenue - TRC 35-258 e
Net protected cell income - TRC 35-260. ...

Net farm profit (loss), if no detail entered - TRC 31-662........  Farm Income

Recapture under Sec 179 and 280F, if no detail
entered on Form 4797

/" Do not carry recapture under Sections 179
and 280F from Form 4797

Bad debt recapture, if no detail entered on............................. BadDebts
Passive loss disallowed, if no detail entered on Form 8810
Credit for alcohol used as fuel, if no detail entered on.................... Form 6478
Section 91 transferred loss amount, if ne detail entered on............. Form 8858

Section 846 transition adjustrment TCJA

Remaining Salvage Subrogation/Supplemental Sec 846 adjustment TCJA.._.....

TCC Other Income - TRC 31-900 Amount

Total

Figure 3:6
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Electronic Organizer

RECLASSES IN BALANCE

To keep areturn in balance, reclass items must be balanced entries. You can verify that the return is balanced
by navigating to the Total Reclasses per reconciliation field, which is the second field shown on the screen
below and is outlined with a box.

Navigation: Tax Forms > Federal > 1120-PC Corporate Income Tax Return > Tax Summary > Tax to
A/S Reconciliation tab

Organizer Tax Forms Collapse All[=] Income Tax Return Summary Tax to A/S Recenciliation Taxable Income Reconciliation Federal Tax Forms Summary

~* [ Federal ~ Tax Return to Annual Statement Reconciliation

Billing Statement
~ [3 1120-PC - US Corporation Inc Tax Return
Tax Summary
1120-PC US Corporate Income Tax Return
Schedule M-3
» [ Sch D/8949-Capital Gains and Losses
Sch N - Foreign Operations of US Corp
Sch O - Consent Plan and Apportionment
Sch PH - Personal Holding Company Tax
Sch UTP - Uncertain Tax Position Stmt
¥ [ Form T - Forest Activities Schedule
» [ 851 - Affiliation Schedules
» [ 926 - US Prop. Transfer to Foreign Cor
» [ 965 - Inclusion of Deferred Foreign Inc
» [ 966 - Corp. Dissolution or Liquidatio
» [ 970 - LIFO Election
» [ 972 - Consent for Income Inclusion

973 - Deduction for Consent Dividend

NAIC NET INCOME TO TAXABLE INCOME RECONCILIATION

Taxable income per reconCiliation..............

58,158,234 n

Total reclasses per reconcilialion. ...

1

Taxable income per reconciliation without regard to reclasses.......................
Taxable income per 1120-PC page1

Total difference. ..

INVESTMENT INCOME RECONCILIATION

Total investment income per schedule Aor B
Total investment income per NAIC annual statement after adjustments...............

Total tax to annual statement differences.............

CAPITAL GAIN (LOS5S) RECONCILIATION

Totals from NAIC annual statement...............o e
Total gain or loss from Form 1120, Schedule D
Total reconciling items..__

Total tax to annual statement differences..............

58,158,234
a8, 231,254

-10,833,000

31,695,937 1

31,695,937 1

Figure 3:7
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Electronic Organizer

You can select the field and use the down arrow link to open the Summary of Statutory Reclassed Items. If
the return is in balance, a message stating this appears at the bottom of the screen.

Summary of Statutory Reclassed Items

Totals
PrEmiLm IMEGIMIE .o 1
Investment Income 4,332,316 1
DRI INMOIMIE ottt e een s 1
EHDEMSES oottt ettt et -4,332,316 3
B S B ettt et et et en 1
Special ltems el

PETINCOME (e

IReclasses are in balance. I

Figure 3:8
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CHAPTER 4: SETTING UP A RETURN

To create and set up your insurance return, choose the proper return type, entity type, and data source. If these
selections are not accurate, the compute, print, and e-file components will not work correctly when creating an
insurance consolidation.

There are two ways to create your return:

« Rollover a previous year’s return, so that the prior year ending balances are shown in the beginning
balance columns for the current year.

« Create an entirely new return, and either import or enter the beginning and ending balances for the
balance sheetitems.

STEP 1: ROLLOVER A RETURN FROM THE PRIOR
YEAR’S RETURN

ROLLOVER OF AN 1120 RETURN

Rollover of an 1120 parent or subsidiary company is relatively straightforward. Choose the rollover option on
the side of the screen or use a batch rollover to transfer your year end balances to the current year return.

ROLLOVER OF THE 1120-PC AND 1120-L RETURNS

We provide two options to flow prior year balances to the tax return:
o Option 1: The balances come from the current year Annual Statement.

e Option 2: The balances come from rolled over prior year balances.

THOMSON REUTERS
1120 INSURANCE GUIDE



42 Chapter 4: Setting Up a Return
Step 2: Enter Federal Tax ID Number and Entity Information

STEP 2: ENTER FEDERAL TAX ID NUMBER AND ENTITY
INFORMATION

The federal tax ID number (EIN) is mandatory for all returns except for elimination returns, subgroup
subconsolidation returns, divisions, and consolidated returns. The tax ID can be reviewed in Organizer >
General Information > Basic Return Information > Entity Information tab of the return created.

Organizer Tax Forms Collapse All 5] Entity Information Return Information Return/Entity Type Conversion

A
QuickForm N
[~ [ General Information
Business Activity Codes
Basic Return Information

Return and Print Options ENTITY INFORMATION

» 3 Questions
Name

Paid Preparer/ERO Information

Name (cont'd)
Bank Information
[] Name change
» [ Tax Defaults 1 Entity number

» [ Federal E-file

EIN
» [ Federal E-file Extension [ Applied for

» [J Amended Return
» [J Income and Deductions ADDRESS

» [J Gains and Losses Addre:

» [ Taxes Cit

» [3 Credits State. (None selected) -

» [ Payments and Extension zP.

Figure 4:1

REQUIREMENTS

The tax ID (EIN) is required/not required for the following types of entities:

« Parent, Subsidiary, or Corporate Single Entity: The tax ID is required for the single company
returns.

« Subgroup Subconsolidation: Tax ID is not required.

« Top consolidation (topcon) company: The Parent tax ID transfers to this level. This is not required.
« Eliminations: Tax ID is not required.

o Division: Tax ID is not required.

« Divisional Subconsolidation: Tax ID is required, as this represents a legal filing entity.

If you have applied for a tax ID, the EIN Applied for check box is available on the Entity Information screen
below the EIN.
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Step 3: Choose Return/Entity Type

STEP 3: CHOOSE RETURN/ENTITY TYPE

Review the data found on the Entity Information tab after creating or rolling over a return.

Navigation: Organizer > General Information > Basic Return Information > Entity Information tab.

Entity Information Return Information Return/Entity Type Conversion

HELP

Business Activity Codes

RETURN / ENTITY TYPE

Return type 1120 - U.S. Corporation -
Entity type Corporate single entity -
View Federal Deactivation
DATES
Date incorporated..... [ MM/DD/YYYY Pre-1900

Fiscal year beginning..............

Fiscal year ending... ... oo |MM/DD/YYYY Transfer to Membersl

Figure 4:2

Scroll down to the Return/Entity Type section. From the drop-down lists, select the Return Type and Entity
Type.

STEP 4: COMPLETE DATA ENTRY IN THE ORGANIZER

Complete the data entry for the following items in the Organizer:

1. Enter the Ending Balances:

For 1120-L, navigate to Organizer > Life Electronic Organizer > Page 3 > Sch F - Lines 1 through
6. Select the applicable tab and enter reserves ending balances.

For 1120-PC, if the annual statement is not used, navigate in Organizer > PC Electronic Organizer >
Page 5. Enter the current premiums and losses in Schedule E - Premiums and Schedule F -
Losses.

2. Enter the detail for Gains and Losses: Navigate to Organizer > Gains and Losses and enter amounts if
required for your tax return.
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44 Chapter 4: Setting Up a Return
Step 4: Complete Data Entry in the Organizer

3. Enter the required detail for depreciable assets or use the summary override form at Income and
Deductions > Deductions > Depreciation and Amortization > General Depreciation and
Amortization > Asset Detail or 4562 Information > 4562 Overrides.

D/* DIF files are available for importing Schedule M-3 data for both 1120-L and 1120-PC
- return types.

4. Enter the detail for Net Operating Losses: Navigate to Organizer > Carryover, Footnotes, and
Invoices > Carryovers > Computed Carryover Detail > NOL Carrybacks or Carryover Detail to
enter the carryover Net Operating Losses (NOL). Carryover NOL is entered by type of NOL, such as
Regular NOL, Contributions, or Capitol Losses. There is a separate tab for each type.

5. Enter any other applicable items for your return, such as Schedule M-3.
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CHAPTER 5: 1120L RETURNS

The IRS Form 1120-L, the US Life Insurance Company Income Tax Return, is used to report the income, gains,
losses, deductions, and credits, and to figure the income tax liability of life insurance companies. Every
domestic life insurance company, as well as every foreign corporation that would qualify as a life insurance
company if it were a US corporation, must file a Form 1120-L. Insurance companies other than life insurance
companies should file Form 1120-PC, the US Property and Casualty Insurance Company Income Tax Return.

Insurance Company A corporation is an insurance company if more than half of its business during the tax
year is from the issuance of insurance or annuity contracts, or the reinsuring of risks underwritten by insurance
companies.

Life Insurance Company A life insurance company is an insurance company in the business of issuing life
insurance and annuity contracts, either separately or combined with health and accident insurance, or
noncancellable contracts of health and accident insurance that meet the reserves test in Section 816(a).
Guaranteed renewable life, health, and accident insurance that a corporation cannot cancel but reserves the
right to adjust premium rates by classes, according to experience under the kind of policy involved, is treated as
noncancellable.

LIFE INSURANCE RESERVES TEST

The reserves test requires life insurance reserves, as defined in Section 816(b), plus unearned premiums and
unpaid losses (whether or not ascertained) on noncancellable life, health, or accident policies not included in
life insurance reserves must make up more than 50% of total reserves as defined in Section 816(c). When
determining whether the reserves test has been met:

« Life insurance reserves and total reserves must each be reduced by an amount equal to the mean of the
aggregates at the beginning and end of the tax year, of the policy loans outstanding with respect to
contracts for which life insurance reserves are maintained.

« Amounts set aside and held at interest to satisfy obligations under contracts that do not contain permanent
guarantees with respect to life, accident, or health contingencies must not be included in either life
insurance reserves (Section 816(c)(1)) or other reserves required by law (Section 816(c)(3)).

« Deficiency reserves must not be included in either life insurance reserves or total reserves.

FAILED LIFE

See Failed Life (page 46) for more information.
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1120L Unique ltems

1120L UNIQUE ITEMS

See Unique Items (page 47) for more information.

FAILED LIFE

Alife insurance company is in the business of issuing life, annuity, and certain health insurance policies. A failed
life return is a Life Insurance company with a Life Insurance Annual Statement that does not meet the reserves
qualifications to file on an 1120-L tax return per IRS rules. An insurance company that does not qualify as a life
insurance company under the IRS rules files an 1120-PC tax return for the IRS’s filing purpose.

Using The Life NAIC Import

If you have a failed life tax return and you want to import the Life Annual Statement, the return must be created
as an 1120-L tax return in our tax application. After creation, you must import the Life Annual Statement and
check the Failed Life check box to convert the life insurance data from the 1120-L. We then automatically
populate the 1120-PC tax return. The 1120-PC tax return is the tax return visible on the Tax Forms page for
filing to the IRS. The 1120-L tax return is disabled.

Which type of subgroup Subconsolidation does the failed life belong to?

Without regard to the way you created the failed life or the method you used to populate the failed life return
data, the failed life tax return (1120-PC) is included in the 1120-PC subgroup for consolidation purposes. It can
be confusing since you might have to create the failed life return by creating a life return to use the Life Annual
Statement transfer, and then convert it to an 1120-PC return. The PC subgroup Subconsolidation consists of all
the 1120-PC returns to be filed to the IRS, whether they are created as 1120-PC, or converted to 1120-PC
because they are failed life returns.

Failed Life Conversion

Use the following steps to help you create your failed life return, if you are using the Life Annual Statement
transfer method.

1. Create an 1120-L return.

2. Do notenter any numbers in the 1120-L Organizer at this point. Wait until after conversion to the 1120-PC
to enter amounts in the Organizer.

3. Transfer the Life Annual Statement.
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Unique ltems

4. Turn off Auto Compute in the 1120-L return.

5. Inthe Failed Life Return section, select both check boxes at the bottom of the screen. One box
deactivates the 1120-L; the other activates the 1120-PC area and the tax form. The failed life check boxes
are at on the screen shown in the Organizer > General Information > Basic Return Information >

Entity Information.

FAILED LIFE RETURN

- If the life annual statement is available:
1 Select 1120-L as return type
2 Select 1120L - Life annual statement as data source
3 Check this box to activate the 1120-PC form. e |
4 Check this box to deactivate the 1120Lform..._. ... ]

- If the life annual statement is NOT available:

1 Select 1120-PC as return type

2 The data source should be default to electronic organizer after an entity type is selected

Figure 5:1

6. The 1120-PC tax forms now appear in Tax Forms and the 1120-PC Organizer. All Organizer entries must
now be made in the 1120-PC Organizer, not in the 1120-L Organizer.

7. Ifthis failed life return is to be consolidated with other returns, it must be included in an 1120-PC subgroup
Subconsolidation.

UNIQUE ITEMS

DAC — Deferred Acquisition Costs

Deferred Acquisition Costs (DAC) are amortized under Section 848 and entered mostly on 1120-L returns,
and occasionally on 1120-PC returns. The Deferred Acquisition Costs are located on the 1120-L, Page 4,
Schedule G (go to Tax Forms > Federal > 1120-L - US Corporation Inc Tax Return > 1120-L - US
Corporation Inc Tax Return > Page 3). These expenses are incurred when gathering new premiums that
then must be amortized on the 1120-L tax return.
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Unique ltems

Annual Statement Users

The tax application automatically transfers in Premiums, Advance Premiums, and Deferred and
Uncollected Premiums from the Annual Statement.

Adjustments to DAC

To make adjustments in each premium type, choose a tab in the Direct Business Premiums Worksheet
such as Annuity, Group Life, or Other Life. In the Other Adjustments to Premiums column in the last
row, you can enter adjustment in the field titled Other Adjustments.

The Totals tab sums all three tabs for review purposes.

Navigation: Organizer > Deferred Acquisition Costs > Direct Business > Direct Business Premiums
Worksheet > Totals tab

Totals Annuity Group Life Other Life

Direct Business - Gross Premiums

Note: To manually override, enter amounts with the same signs, positive or negative, as they
should appear in the workpapers.

Total

Premiums and other consideration.__.____

Deposit-type funds........cocooe oo

Elimination of Non-Specified Insurance
Contracts & Other Reclasses:

Pansinn nlan conteacts

Figure 5:2
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Navigation: Organizer > Deferred Acquisition Costs > Direct Business > Direct Business Premiums

Worksheet > Annuity tab

Totals Annuity Group Life Other Life

Direct Business - Gross Premiums

Note: To manually override, enter amounts with the same signs, positive or negative, as they
should appear in the workpapers.

Ordinary Individual Group
Annuities Annuities

Premiums and other consideration...
Deposit-type funds.
Elimination of Non-Specified Insurance
Contracts & Other Reclasses:
Pension plan contracts....
Flight insurance contracts.....
Qualified foreign contracts_.

C contract

Other non-specified adjustments......
Reclass of premiums/non-qualifying..

Total

Adjustments to Premiums:
Advance -EOY.

Advance -BOY.

Premium deposit funds - EOY............coovcnriiicns
Premium deposit funds - BOY.

Fee

Employee benefits premiums. ...

Policy exchange:

Deferred and uncollected - EOY......
Deferred and uncollected - BOY......
Policyholder dividends under §808(e)..
Premiums waived

Partial surrender or withdrawal. ...
Settlement option amounts.

Guaranty association...

Dividend

Policy loan:

Other adijt

Total

Total Direct Premiums and Other
Consideration Subject to §848.

Type of Specified Contract:
Annuity.

Group Life.

Other Life.

Figure 5:3

Schedule T

The Annual Statement Schedule T provides state premium numbers for the state tax returns. Schedule T in
the Organizer is automatically populated when you import the Annual Statement for Life and PC Annual
Statement returns. The premium total numbers also populate the Allocation and Apportionment area

automatically for the states once the state area is activated.

THOMSON REUTERS
1120 INSURANCE GUIDE



50 Chapter 5: 1120L Returns
Unique ltems

Navigation: Organizer > Life Annual Statement > Page 48 - Schedule T

Alabama - North Carolina North Dakota - End Line 57 Write-Ins Line 57 Detail Line 94 Write-Ins Line 94 Detail

Life Schedule T - Premiums and Annuity Considerations Allocated by States and Territories

(] Check to suppress Schedule T from being flown to Allocation Apportionment area

1 2 3 4 5

States, Etc Is Insurer Life Insurance Annuity Accident and Health Other
Licensed? Premiums Considerations Premiums Considerations
(Yes or No)
1 Alabama AL
2 Alaska AK
3 Arizona AZ
4 Arkansas. AR
5 California cA
6 Colorado co
7 Connecticut. cr
8 Delaware DE
9 District of Columbia Dc
10 Florida FL
11 Georgia. GA
12 Hawail HI
13 Idaho. D

Figure 5:4

D/‘ If you want to suppress the Schedule T premium amounts from populating the States Allocation
- and Apportionment area, use the check box in the Organizer at the top of the Schedule T. The
figure above shows the check box to suppress Schedule T.

Organizer users can only enter the data directly into the Allocation and Apportionment area if needed.

Navigation: Organizer > States > Allocation and Apportionment > Data Entry > Sales Data Entry >
Receipts from Sales

| Receipts from Sales | Throw Out Sales

Sales Within Sales Without Sales Within Sales Within State
State to State to State to to Nontaxable

Within State Within State U.S. Government Jurisdictions

Alabama..............
Alaska................
Arizona................
Arkansas............

California...

Colorado................
Connecticut..........

Delaware..............

Figure 5:5
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CHAPTER 6: 1120-PC RETURNS

The IRS Form 1120-PC, the US Property and Casualty Insurance Company Income Tax Return, is filed to
report the income, gains, losses, deductions, credits, and to figure the income tax liability of insurance
companies other than life insurance companies. Life Insurance companies file the Form 1120-L, unless they
are failed life returns. If it is a failed life return, it is filed to the IRS on an 1120-PC return.

1120-PC UNIQUE ITEMS

Loss Reserve Discounting (LRD)

See Loss Reserve Discounting (LRD) (page 51) for more information.

Salvage and Subrogation

See Salvage and Subrogation (page 61) for more information.

Failed Life

See Failed Life (page 46) for more information.

Deferred Acquisition Costs (DAC)

The Deferred Acquisition costs (DAC) are most commonly entered on the 1120-L returns. These are the
expenses incurred when gathering new premiums and amortized under Section 848.

See DAC - Deferred Acquisition Costs (page 47) for more information.

LOSS RESERVE DISCOUNTING (LRD)

LRD has two ways to discount: company experience and treasury experience. The tax software supports the
Treasury basis (IRS) and the Company experience basis calculations, computing the discount factors back to
accident year (AY) +14 years.
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Loss Reserve Discounting (LRD)

The Loss Reserve Discounting (LRD) calculations require the transfer of information from Schedule P of the
Property and Casualty Annual Statement and the company payment pattern calculations also require
information from Schedule P. You can download this information from the NAIC files using either the 1120-PC
and LRD combined transfer or the separate LRD transfer, or you can enter the information into the LRD Annual
Statement screens.

Loss reserves can be discounted using the IRS discount factors or company payment patterns. The system
default for Loss Reserve Discounting uses the IRS factors. A combination of the IRS factors and company
payment pattern can be used. This option is provided by the company’s line of business.

D/‘ On a title insurance company, we do not calculate the IRS discount factors for the miscellaneous
- casualty area.

For company experience basis, the NAIC file can never synchronize with the LRD schedule in Organizer. The
reasons are:

1. The two-year gap between the NAIC Schedule P data and tax. For example, the 2019 imported Schedule
P data is not used for the tax calculation until the 2021 tax year.

2. Company experience basis requires a minimum of five (5) years of a company’s historical payment
pattern data. The current year NAIC Schedule P does not have this.

For example, for a company to use company experience as the basis to discount its loss reserves in the 2021
tax year, it needs data from NAIC Schedule P for tax years 2020, 2019, 2018, 2017, and 2016. To see how our
software calculates LRD using the company experience basis, you need to enter, at a minimum, Schedule P
data for years 2020, 2019, 2018, 2017, and 2016 into Organizer. In real life, our software automatically rolls
over and transfers Schedule P prior year information for you.

LRD Lines

The lines of business can be calculated all by one method or a combination of two methods: the company
payment pattern and/or the IRS payment pattern. The company payment pattern comes from the Annual
Statement transfer. The IRS payment pattern is a compilation of the industry averages. The loss reserves can
be chosen by lines; one calculated by the payment pattern and the other calculated by the IRS payment pattern
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Compute Options

Chapter 6: 1120-PC Returns

Loss Reserve Discounting (LRD)

Navigation: Organizer > Loss Reserve Discounting > Options > Compute Options

On the Elections tab, select the lines of business and years to discount using company payment pattern on

this tab.

Organizer Tax Forms

» [ General Information
» [ Federal E-file Extension
» [ Federal E-file

» [ PC Electronic Organizer

Organizer  Loss Reserve Discounting

Collaps

A

Options » Compute Options  _ Elections.

Elections IRS AY+9 Discounting

Loss Reserve Discounting Elections

Select the lines of business and election years to indicate the use of company

payment pattern

SHORT TAIL LINES

~ [ Loss Reserve Discounting . 2012 2017
Special Property o O
~ [ Options
Auto Physical Damage o o
Fidelity, Surety, Guaranty. o O
Print Suppression Options. Other (Credit, A&H). o O
Financial Mortgage Guaranty. o O
Discounting Summary
Warranty o O
» [ Short Period Lines
»
[ Long Period Lines LONG TAIL LinES
»
[ salvage and Subrogation 2002 2007 2012 2017
» [ Deferred Acquisition Costs
Private Passenger Auto O o o o
> O Amended Return Commercial Auto. O o o o
» [J Income and Deductions Workers' C o o o d
Multiple Peril O o o o
> O Gains and Losses Medical Professional Liability
» [ Taxes A Occurrence O O o o
< > Claims Made O o o o

Figure 6:1

The IRS AY+9 tab shows the payment pattern the IRS uses in computing discount factors.

Revenue Procedure 98-11:

Private Passenger ..

Worker's Compensation
Multiple Peril.

Medical Malpractice
Occurrence....

Claims Made...

Other Liability
Occurrence....

Products Liability
Occurrence....

Claims Made. ..

Commercial Auto..................

Claims Made.....................

Elections | IRS AY+9 | Discounting

IRS AY+9 Payment Pattern

0.1159000000000

2.0515000000000

-0.0821000000000

S

[

=)

- 0.1784000000000

10.5381000000000

0.3700000000000

.7656000000000

.2471000000000

.6892000000000

1.2223000000000

Figure 6:2

THOMSON REUTERS
1120 INSURANCE GUIDE

53



54 Chapter 6: 1120-PC Returns

Loss Reserve Discounting (LRD)

The Discounting tab gives you options such as:

Discount loss reserves separately for accident year’s prior to AT +10.

Discount loss reserves using only the unpaid losses, column 24 of Sch P.

« Discount International loss reserves using the 10 year method.

Do not apply the discounted statutory reserve limited (S846).

Check to discount Other, Credit and AH (PartL).

Elections IRS AY+9

Loss Reserve Discounting Options

DISCOUNTING RESERVES

[ Discount loss reserves separately for accident years prior to AY+10

[] Discount loss reserves using only the Unpaid Losses, column 24, of Schedule P
[ Discount International loss reserves using the 10 year method

[] Do not apply the discounted statutory reserve imitation (§846(a)(3))

[[] check to discount Other, Credit and AH (Part L)

Figure 6:3

Print Suppression Options

Navigation: Organizer > Loss Reserve Discounting > Options > Print Suppression tab

On the Global tab, the Global LRD Print Suppression Options allow you to suppress the following items by
selecting the check box:

o Loss Reserve Discounting Summary
o Shortand Long period summaries

All detail

Company payment pattern detail

+ Reserve detalil

Group A&H, Other A&H detail
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Loss Reserve Discounting (LRD)

Global Short Period Long Period

Global LRD Print 8ugpression Options

SUPPRESS SUMMARY AND DETAIL

[[] Loss Reserve Discounting Summary
["] short and long period summaries
[ Al detail

O Company payment pattern detail

[ Reserve detail

O Group A&H, Other A&H detail

Figure 6:4

On the Short Period tab, the Short Period Suppression Options allow you to suppress the following:

o Suppress Summary and Detail print items by selecting an item check box.

« Suppress Company Payment Pattern Detail by Line of Business by selecting an item check box.

« Suppress Reserve Detail by Line of Business by selecting an item check box.
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Loss Reserve Discounting (LRD)

Global Short Period Long Period

Short Period LRD Print Suppression Options

SUPPRESS SUMMARY AND DETAIL

I Al summary and detail print

[[] shert Period Loss Reserve Discounting Summary
[ Al detail

O Company payment pattern detail

[[] Reserve detail

SUPPRESS COMPANY PAYMENT PATTERN DETAIL BY LINE OF BUSINESS

[] Special Property

[ Auto Physical Damage

[ Fidelity and Surety

[ other (Credit, A&H)

O Financial/Mortgage Guaranty
O Warranty

SUPPRESS RESERVE DETAIL BY LINE OF BUSINESS

[[] Special Property

[] Auto Physical Damage

[ Fidelity and Surety

[ other (Credit, A&H)

O Financial/Mortgage Guaranty

[ warranty

Figure 6:5

On the Long Period tab, the Long Period Suppression Options allow you to suppress the following:
e Suppress Summary and Detail
« Suppress Company Payment Pattern Detail by Line of Business

o Suppress Reserve Detail by Line of Business
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Global Short Period | Long Period |

Long Period LRD Print Suppression Options

SUPPRESS SUMMARY AND DETAIL

Al summary and detail print

] Long Period Loss Reserve Discounting Summary
[ Al detail

O Company payment pattern detail

[[] Reserve detail

SUPPRESS COMPANY PAYMENT PATTERN DETAIL BY LINE OF BUSINESS

1 Auto Liability

[ private Passenger Auto
[ commercial Auto

[C1 worker's Compensation
O Multiple Peril

[ Homeowners/Farmowners
1 commercial Multiple Peril
O Special Liability

[ Medical Malpractice

1 other Liability

[ Products Liability

SUPPRESS RESERVE DETAIL BY LINE OF BUSINESS

O Auto Liability

"1 worker's Compensation
O Multiple Peril

[ Medical Malpractice

1 other Liability

[ international

[ Reinsurance

[ Boducts Liability

Figure 6:6

Discounting Summary

Navigation: Organizer > Loss Reserve Discounting > Discounting Summary > Summary Totals tab

This folder is where most of the LRD data is located.

« Summary Totals tab

Short Period Lines tab
« Long Period Lines tab

Accident and Health tab

IRS Discount Factors tab.

Chapter 6: 1120-PC Returns

Loss Reserve Discounting (LRD)

57
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Loss Reserve Discounting (LRD)

Summary Totals Short Period Lines Long Period Lines Accident and Health IRS Discount Factors

Loss Reserve Discounting Summary

Discount Rate:

2003 % 2007 % 2011 % 2015 %
2000 % 2004 % 2008 % 2012 % 2016 %
2001 % 2005 % 2009 % 2013 % 2017 %
2002 % 2006 % 2010 % 2014 % 2018 %

1 Schedule P - Short Period Line:

2 Schedule P - Long Period Line:

3 Other Accident, Health and Disabilit

4 Total Discounting Unpaid Loss

OR

Total Discounting Unpaid Loss Adj Override

Figure 6:7

SHORT PERIOD LINES

For the following short period lines, you can see the amounts from the Company Payment pattern: the Annual
Statement and the Loss Reserve Calculations. The Company Payment Pattern shows the last five years of
data. The Annual Statement section displays information from columns 23, 24, 35, and 36 of Schedule P. The
Loss Reserve Calculation section displays statutory reserves, discounted anticipated Salvage and
Subrogation, and Discounted Loss Reserves for the last two years.

Navigation: Organizer > Loss Reserve Discounting > Discounting Summary > Short Period Lines
tab

Summary Totals Short Period Lines Long Period Lines Accident and Health IRS Discount Factors

Loss Reserve Discounting - Summary of Short Period Lines

Discounted Discounted
Book Reserves Tax Reserves Discount

1 Special Property.....................
2 Auto Physical Damage.................
3 Fidelity and Surety..................

4 Other (Credit, A&H)...................
5 Financial/Mtg Guaranty.................
6G

TTOtalS......ooe

LRD Optmnsl

Figure 6:8
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Chapter 6: 1120-PC Returns

Loss Reserve Discounting (LRD)

o Special Property

Auto Physical Damage

Fidelity and Surety

« Other (Credit & A&H)

Financial/ Mortgage Guaranty

LONG PERIOD LINES

For the following Long period lines, you can see the amounts from the Company Payment pattern, the Annual
Statement, and the Loss Reserve Calculations. The Company Payment Pattern shows the last fifteen years of
data. The Annual Statement section displays information from columns 23, 24, 35, and 36 of Schedule P. The
Loss Reserve Calculation section displays statutory reserves, discounted anticipated Salvage and
Subrogation, and Discounted Loss Reserves for the last 15 years.

Navigation: Organizer > Loss Reserve Discounting > Discount Summary > Long Period Lines tab

Summary Totals Short Period Lines | Long Period Lines | Accident and Health IRS Discount Factors

Loss Reserve Discounting - Summary of Long Period Lines

Discounted Discounted
Book Reserves Tax Reserves Discount

1 Auto Liability. ...

2 Workers Compensation......

3 Multiple Peril ...

4 Medical Malpractice....................
5 Other Liability....................._.
6 International..............ccocooeeeennnee
7 Reinsurance. ...

8 Products Liability. ...

9Totals.... ...

LRD Options

Figure 6:9
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60 Chapter 6: 1120-PC Returns

Loss Reserve Discounting (LRD)

« Auto Liability

« Worker’'s Compensation

o Multiple Peril

o Medical Professional Liability
o Other Liability

o International

« Reinsurance

o Products Liability

ACCIDENT AND HEALTH

Summary of Group Accident and Health policies unpaid losses.

Navigation: Organizer > Loss Reserve Discounting > Discounting Summary > Accident and Health
tab

Summary Totals Short Period Lines Long Period Lines | Accident and Health | IRS Discount Facters

Summary for Accident and Health

1 Group Accident and Health unpaid losses_......... .
2 Group Accident and Health LAE eXpenses................coooiiiiii e
3 Other Accident and Health unpaid losses ...

4 Other Accident and Health LAE expenses..........................................

e I R

5 Less: Reserves not eligible for half-year discounting...............c.oocoooiiins

6 Net Accident and Health Reserves subject to discounting™.............................. .

7 Discount Factor................

8 Accident and Health discounted reserves ...

9 Accident and Health reserves subject to Morbidity discounting.............................

10 Total adjustment for discounting Accident and Health loss reserves......................

* Statutory reserves from Schedule P, Part L should be adjusted to reflect the amounts represented on

line 6 above......... Col 24 Adjustmentq

Figure 6:10
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Chapter 6: 1120-PC Returns

Salvage and Subrogation

o Group Accident and Health unpaid losses

o Group Accident and Health LAE expenses

o Other Accident and Health unpaid losses

o Other Accident and Health LAE expenses

« Less: Reserves not eligible for half-year discounting

« *Net Accident and Health Reserves subject to discounting*

« Discount Factor

« Accident and Health discounted reserves

« Accident and Health reserves subject to Morbidity discounting

« Total adjustment for discounting Accident and Health loss reserves

* Statutory reserves from Schedule P, Part L should be adjusted to reflect the amounts represented on line 6
above.

SALVAGE AND SUBROGATION

The Revenue Recognition Act of 1990 (RRA) requires that, for the tax years beginning after 1989, salvage and
subrogation (S&S) recoverable must be included in determination of losses incurred. This provision is required
whether or not an insurer reduced its unpaid losses and loss adjustment expense (LAE) by anticipated S&S
recoverable for statutory accounting purposes. Recoverable amounts include those amounts applicable to paid
and unpaid losses and LAE and are calculated for tax purposes on a discounted basis. Life insurance
companies are not subject to the tax treatment of S&S recoverable.

Salvage is the sale of damaged goods for which the insured has been indemnified by the insurance company.
The most typical example of salvage is when the insurance company sells the remains of a car to which it has
taken title after the insurance settlement with the insured for the total precrash value of the car.

Subrogation is the collection by the insurance company of the amount of a paid claim from a negligent third

party or his insurer. Although subrogation is a liability concept, you might well find that subrogation actually

outweighs salvage even in your company’s auto physical damage experience. For example: to speed claim
settlement, your company has paid for the physical damage of your not-at-fault insureds and then collected
subrogation from the insurance companies of the at-fault drivers.

Salvage Recoverable is the estimated salvage and subrogation (net of expenses) to be recovered on all claims
incurred to date, whether reported or unreported.

THOMSON REUTERS
1120 INSURANCE GUIDE
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Salvage and Subrogation

Methods of Calculation of Salvage and Subrogation

To calculate the Salvage & Subrogation (S&S) option for the Annual Statement, Schedule P column 24 must be
selected for the amounts to flow from the LRD screens to the S&S discount screens.

Two methods apply when discounting the S&S area:
« Alternative 1: This method uses the industry pattern.

o Alternative 2: This method uses the same factors used to discount unpaid losses.

S&S Options

Navigation: Organizer > Salvage and Subrogation > Options > Compute Options

e Global Calculation Suppression: Two options are available to suppress all salvage and subrogation
calculations and to discount salvage and subrogation separately for accident years prior to AY+10.

Compute options y
€
Suppress all salvage and subrogation calculations. ... ... ’ ............ [l
Discount salvage and subrogation separately for accident years prior to AY+10....___. ’ ............ [l
£
y

Figure 6:11

o Print Suppression Options: Select one of the first two check boxes to suppress various detail
summaries or select All detail.

Global Short Period Long Period

Global Salvage and Subrogation Print Suppression Options

SUPPRESS SUMMARY AND DETAIL

] Discounted Salvage and Subrogation Summary
[] Short and long period summaries
L1 Al detail

Figure 6:12
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Chapter 6: 1120-PC Returns 63

Salvage and Subrogation

« Discounting Summary: This is where the discounting amounts can be seen for the Short and Long
period lines. The IRS Table is also included here for both short and long period lines. It displays the
Salvage Discount factors based on published revenue procedures.

Summary Totals Short Period Lines Long Period Lines IRS Table

Discounted Salvage and Subrogation Summary

Statutory Discounted
Sal/Sub Amounts Discount Sal/Sub Amounts

1 Short Period Lines...............

2 Long Period Lines...............

3Totals........

Figure 6:13
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CHAPTER 7: STATE RETURNS

ACTIVATING STATE RETURNS

1120 state returns are activated on the state activation spreadsheet, found when you navigate in Organizer >
States > State and City Activation > State and City Activation.

For each state, select the check box in column B - State Activation for a single company or consolidated
return member company.

In addition, select the Return Type and Entity Type by selecting the down arrow beside each item to open a
list of options.

Organizer Tax Forms Collapse HELP
State Activation
FAQ Spreadsheet Guide Video Common State Spreadsheets
» [ Letters and Filing Instructions ~
» O Informational Forms O Refresh L Fullscreen
» [ Foreign Information A B D E F
» [ carryovers, Footnotes, and Invoicing N STATE INSURAN
1 ACTvATION RETURNTYPE  ENTITY TYPE FINANCIAL RETURN Eec
» [ Federal Tax Elections
FEDERAL franster
+ [ states 2 1120-L Single iy
3 ALLOCATION & APPORTIONMENT ]
¥ [ State and City Activation 4 ALABAMA ] 1120 single O
5 ALASKA O 1120 Single
State and City Activation & ARIZONA O 1120 Single
7  ARKANSAS (] 1120 Single
Kentucky Common Form Cities 8 CALIFORNIA ] 1120 Single
Michigan Cities 9 COLORADO ] 1120 Single
10 CONNECTICUT [1120 |~ hale
Ohio Cities 11 DELAWARE 0 1120
13  DISTRICT OF COLUMBIA m] 11208 —hgle
DIF Import Ohio City Codes 14 FLORIDA 1 1120 Single
» [J Common State 15 GEORGIA O 1120 Single (None selected)
16 HAWAII O 1120 Single O
» O3 state E-file 17 IDAHO O 1120 Single
18 ILLINOIS ] 1120 Single
» [ Allocation and Apportionment 19 INDIANA [l 1120 Single O
21 IOWA O 1120 Single O
» 3 Connecticut 5 ) =l 100 -
i v 4 <> »I| States Cities 1)« ]
» [ State Intangible
< > <

Figure 7:1
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65 Chapter 7: State Returns

Activating State Returns

In a consolidated return, mark states to combine by selecting Combine in the drop-down list in column C.

Help
A = d Guide Video Co an State Spreadshes
State Activation {i Spreadsheet Guide ideo Common State Spreadsheets
3
i 5 |
A D | E
1 e Ly | ACTIVATION/CONSOLIDATION RETURNTYPE — ENTITY TYPE
2 |FEDERAL Comhbing All States |1 120 Top Coensolidation
3 |ALLOCATION & APPORTIONMENT (None selected)

MBﬁW\ Combine | B Top Consolidation
5 |ALASKA one selected 20 Top Censolidation
6 |ARIZONA Active 20 Top Coensolidation
7 |ARKANSAS Aclive 1120 Top Consolidation
8 |CALIFORNIA Active 1120 Top Consolidation
Q |lenineann At 4400 Tan Cancalidat

Figure 7:2

| D/‘ Combine and Active are mutually exclusive options.

Additionally, four states have their own insurance returns: Michigan, Mississippi, New York, and Oregon.
Individual state instructions indicate whether an insurance return only is required, or an 1120 state form can
alternatively be used. The State Activation spreadsheet indicates these insurance states in column G -
Insurance Return Form Type with an entry of Insurance displayed in the cells. Insurance is the default
selection if the federal returnis an 1120-PC or 1120L. The choice of Insurance or C Corporation return is made
atthe member company level (that is, at the parent and subsidiary company level), based on the desired state

return form.

Organizer Tax Forms Co HELP [N
State Activation
- 5 FAQ  SpreadsheetGuide  Video Common State Spreadsheets
» [ Letters and Filing Instructions
» [J Foreign Information A B D E F 6 H
» [ carryovers, Footnotes, and Invoi . STATE INSURANCE RETURN  SUPPRESS
1 AChuATIon RETURNTYPE  ENTITY TYPE FINANCIAL RETURN FoRe o
» [ Federal Tax Elections
2  FEDERAL 1120-L Single
-
D States 3 ALLOCATION & D
~ [ State and City Activation 30 MICHIGAN 1120 Single (None selected) insurance O
31 MINNESOTA O 1120 single Insurance O
State and City Activation 32 MISSISSIPPI 1120 Single O
33 MISSOURI O 1120 Single (None selected) O
Kentucky Common Form Cities 34 MONTANA 0 120 Single 0
Michigan Cities 35 [HEHEESES O 1120 Single O O
36 NEW HAMPSHIRE O 1120 Single (]
Ohio Cities 37 NEVADA O 1120 O
39 NEWJERSEY O 1120 ] O
DIF Import Ohio City Codes 42 NEW MEXICO O 1120 Single (]
NEW YORK
» I Common State 43 1120 Single Insurance O
44 NORTH CAROLINA O 1120 O
» [ State E-file 45 NORTH DAKOTA [m] 1120 Single O
46 OHIO O 1120 Single O O
» [ Allocation and Apportionment 47 OKLAHOMA O 1120 Single O
R 48 OREGON 1120 single Insurance O
O3 Alabama <V UANIA [ 1190 (None selected) m
v 4 < » M| States Cities 1]« I
» [ Arizona
< > <

Figure 7:3
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Chapter 7: State Returns

Allocation and Apportionment

At any consolidated level, only for New York, the selection of Insurance or C Corporation can be transfered to
the member companies by selecting the Transfer to Members (New York) button at the top of column G.

consolidations or state return. In addition, the Electronic Organizer is the only data source

D/* For a PC Basic account, only a federal single company return can be filed, which does not include
available for PC Basic users.

ALLOCATION AND APPORTIONMENT

If Schedule T of the Annual Statement is used, amounts automatically flow from Schedule T to the Sales -
Other Receipts workpaper. Amounts from Schedule T can be suppressed from flowing to the Allocation and
Apportionment area.

Navigation: Tax Forms > States > Allocation and Apportionment > A&A Detail > [State] > Payroll
and Sales > Other Receipts and Misc. Other

Tax Forms States Allocation and Apportionment Detail Florida Workpaper:

Organizer Tax Forms GCollapse All [-] Other Receipts With E h
fithin verywhere

~ [ Allocation and Appartionment o Other Receipts
» [ Factor Review Premiums from Schedule T
* [ Detail

» [ Alabama

» [ Alaska

» [ Arizona

» [ Arkansas

» [ Califomia

» [ Colorado

» [ Connecticut

» [ Delaware

» [ District of Columbia

~ [ Flonda
Allocation
Property

Payroll and Sales

Figure 7:4
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CHAPTER 8: NET OPERATING LOSS

A deduction is allowed on the tax return for an amount equal to the aggregate of (1) the net operating loss
(NOL) carryover, plus (2) the net operating loss carry back. The mixed group consolidation has three types of
net operating losses that can be calculated in the return:

o Non-SRLY net operating losses
o SRLY netoperating losses
o S382 net operating losses.

Each type of net operating loss has its own Organizer where you can enter the amounts. All entries for each
loss type should be entered in the pertinent taxable entity. Depending on the type of NOL, the amount to be
limited must be entered as well.

Navigation: Organizer > Carryovers, Footnotes, and Invoicing > Carryovers > Computed Carryover
Details. Choose the appropriate tab for carrybacks or carryovers.

NON-SRLY NOL

The amount for the Non-SRLY net operating loss must be entered by year in both of the following columns:
Original NOL and Carryover to XXXX, where XXXX represents the current year. The amounts must be entered
in the lowest level subsidiary or parent return in order to consolidate correctly, and not in the top consolidation
There are screen instructions for amounts to be utilized, mainly for print and rollover purposes. These are
consolidated to the top consolidation return and limited against other subgroup income according to the LNL
eligibility check box, IRS rules, and the Organizer overrides. Non-SRLY NOLS are NOT displayed in the lower
entities tax forms.

Non-SRLY NOLS are displayed in the following tax returns:
« Nonlife subgroup Subconsolidation
« NL top consolidation

o LNL top consolidation.

THOMSON REUTERS
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68 Chapter 8: Net Operating Loss
SRLY NOL Entry

Navigation: Organizer > Carryovers, Footnotes, and Invoicing > Carryovers > Computed Carryover
Detail > Carryover Detail > Regular NOL > Non-SRLY NOL tab

Organizer Tax Forms Collaj Non-SRLY NOL I SRLY NOL $382 NOL

» [3 informational Forms

la) [ check to suppress print of original NOL on carryover schedules |

» [O Foreign Information
NON-SRLY NOL

~ [ Carryovers, Footnotes, and Invoicin

*The "Amount Utilized Override” should only be used for consolidated or single returns,

~ [J carryovers
if necessary, to present correct utilization.

v [ Computed Carryover Detail **The "Parent or Subsidiary Utilization" fields are for members of consolidations to correctly
reflect remaining carryovers for print and rollover purposes. Include any carryback to prior
NOL Carrybacks years utilized in the current year utilization.

~ [3 carryover Detail
Do not use the current year generated amount field on a top consolidation or single

Regular NOL company.
AMT NOL with 80% AMTI | ‘ (Overmde)” Nt Gonverted from Parent or NOL Converted from
Carryover to Amount Utilized in . c ,
) o A Year Ending Ci

AMT NOL without 90% (Override) Original NOL 20 20 (Override) Utilization™ Parent/Subsidiary
Contributions
AMT Contributions
Capital Losses

» [ carryovers - History

PN 35 s P PO PR LA R +3 5 PR B SRR R A YV P W VUSRI [P W YOOI Y D S N

» [ Federal Tax Electons v

< >

Figure 8:1
1. Select the check box to suppress the print of original NOL on carryover schedules, if desired.
2. Enter Original NOL and Carryover NOL.

3. Enter carryover amounts if NOL occurred before 8/6/1997.

SRLY NOL ENTRY

The amounts for the SRLY net operating losses must be entered by year in both of the following columns,
Original NOL and Carryover to XXXX, where XXXX represents the current year. The amounts must be entered
in the lowest level subsidiary or parent return in order to consolidate correctly, and not in the top consolidation.

The SRLY NOL amounts are displayed in the following tax returns:
« alower level return where the amount is entered

« the subgroup level

the NL subgroup Subconsolidation

the NL top consolidation and the LNL top consolidation.
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Chapter 8: Net Operating Loss 69
S382 NOL

These amounts are consolidated in the top consolidation and limited to be applied against other subgroup
income according to the LNL eligibility check box.

Read the instructions found on the screen displayed below to determine if you need to enter the amount utilized
(mainly for print and rollover purposes).

Navigation: Organizer > Carryovers, Footnotes, and Invoicing > Carryovers > Computed Carryover
Detail > Carryover Detail > Regular NOL > SRLY NOL tab

Non-SRLY NOL SRLY NOL S 382 NOL

SRLY NOL

(Override)™

Year Ending Carryover to Amount Utilized in
(Override)™ Original NOL 20l 20
o ::-_’-';:-'-'_"_'"_"_" P A b R - e

Figure 8:2

S382 NOL

The amount for the S382 net operating loss must be entered by year in the taxable entity's parent, subsidiary,
or divcon column. In order for the return to consolidate correctly, enter both the Carryover to XXXX (where
XXXX is the current year) and the Limited amount in the lowest level subsidiary or parent return and not in
the top consolidation return. The limitation must be entered to process accurately. S382 NOLs must be applied
against the income of its entity. Any remainder that results is carried forward and used against next year’s
income. The column labeled Amount Utilized is the override column.
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70 Chapter 8: Net Operating Loss
S382 NOL

S382 NOL amounts are displayed in the following tax returns:

« alower level return where the amount is entered

the subgroup level

« the NL subgroup Subconsolidation

the NL top consolidation (topcon) and LNL top consolidation.

Navigation: Organizer > Carryovers, Footnotes, and Invoicing > Carryovers > Carryover Detail >
Regular NOL > S 382 NOL tab.

Non-SRLY NOL SRLY NOL S 382 NOL

SECTION 382 NOL

(Override)

Year Ending Carryover to Limited Amount Amount Utilized in

(Override) Qriginal NOL 20 (Mandatory) 2008

A Pt L Lo o PO el B it | B OO Tt o b,

Figure 8:3

Enter Carryover NOL and Limited Amount (Mandatory).

THOMSON REUTERS
1120 INSURANCE GUIDE



NOL ORGANIZATION AND RULES

The following chart details where NOLs are displayed on the tax return.

NOL -Display chart (by default) Where they
display on the tax return

o
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5382 NOLs entered in the following entity
Parent/ Subsidiary

SRLY NOLs entered in the following entity
Parent/ Subsidiary

non-SRLY NOLs entered in the following entity
Parent/ Subsidiary

X

Figure 8:4

.

NOL Offsetting Rules and Order

The following list of net operating loss rules provides the order that the rules are applied in a Mixed Group

Chapter 8: Net Operating Loss
NOL Organization and Rules

consolidation. Read each NOL type carefully to fully understand before applying.

o NOL carryovers of the same return type (1120 NOLs, 1120-PC NOLs, OR 1120-L NOLs) must be
absorbed by income of the same return type FIRST. Any carryovers that remain can then be utilized by

other subgroup return types.

o NOLs of the same return type (1120 NOLs, 1120-PC NOLs, OR 1120-L NOLs) are utilized by income of
the same return type FIRST. Any carryovers that remain are utilized by other return type subgroups.

e NOLs are offset WITHIN each subgroup before being consolidated to the top consolidation return,
according to the IRS rules. The limited amounts are entered in the Organizer, AND the Organizer

overrides are entered also.

« NOLs in the top consolidation are offset according to the IRS rules,
o Limited amounts must be entered in the Organizer for each Life company, and at the LNL level.

o Limitations, such as the 35 percent limitation on Nonlife subgroup losses against Life subgroup

71

income, are automatically applied when the LNL eligibility is checked for each applicable year of loss.

o The Organizer overrides must be entered.

THOMSON REUTERS
1120 INSURANCE GUIDE



72 Chapter 8: Net Operating Loss
NOL Organization and Rules

NOL Organizer Override Rules

The following items are some of the net operating loss rules for entering Organizer overrides. Overrides should
not be entered on the tax form, nor used to accomplish consolidation accuracy. Instead, use the Organizer
fields at each level for entry overrides.

LEVEL FIELD DESCRIPTION NAVIGATION

LOWEST Override column - In Organizer, Navigate to the override field in the Organizer for
see NOL (SRLY, select check box each return type:

Non-SRLY, S382) labeled Unlimited
Organizer entry NOL

screen computations

» 1120 Organizer > Income and
Deductions > Deductions > Net
Operating Losses section

« 1120-L Organizer > Life Electronic
Organizer > Page 1 - Deductions

« 1120-PC Organizer > PC Electronic
Organizer > Page 2 - Deductions

« 1120-PC Organizer > PC Electronic
Organizer > Page 2 > Schedule A -
Deductions > Miscellaneous
Deductions tabs

18] :1eli{olV Il Override column Navigate to the override field in the Organizer for
AND each return type:

NONLIFE
SUBGROUP « 1120 Organizer > Income and

Deductions > Deductions > Net
Operating Losses section

« 1120-L Organizer > Life Electronic
Organize > Page 1 - Deductions

o 1120PC Organizer > PC Electronic
Organizer > Page 2 - Deductions

o 1120-PC Organizer > PC Electronic
Organizer > Page 2 > Schedule A -
Deductions > Miscellaneous
Deductions tabs
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Chapter 8: Net Operating Loss 73

Limitation of Nonlife NOL Against Life Subgroup Income

LEVEL DESCRIPTION NAVIGATION

TOPCON Overrides must be
entered in the lower
level fields or
subgroups in the
Organizer.

LIMITATION OF NONLIFE NOL AGAINST LIFE SUBGROUP
INCOME

The limitation of Nonlife NOLs against life subgroup income is done automatically in the tax application. The 35
percent limitation is automatically calculated in the top consolidation of the tax return. The computation is the
lesser of the available Nonlife consolidated NOL or the consolidated life subgroup taxable income after capital
loss offset. This computation is done on the yellow workpaper screen shown below.

1 1120, Page 1, line 28 mMinus liNg 290 e
2 Less: Deduction for amounts contributed to a CCF...

3 Met taxable income

4 Inversion gain under Section TETH e
5 Total income under sections 860E(a) and 860

Taxable income from line 3 OR  largest of lines 3 through 5 if applicable

Figure 8:5

Steps required to view computation screens

1. Navigate to Tax Forms > Federal > 1120 Life-Nonlife Consolidation > 1120 Corporate Tax
Return.

2. Onthe 1120, Page 1 tab, navigate to the Tax, Refundable Credits, and Payments section, and find
line 30 - Taxable income. Select the link in the field to take you to the yellow workpaper.

3. Selectin the field of item 1 labeled 1120, Page 1, line 28 minus line 29c.
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74 Chapter 8: Net Operating Loss
LNL Eligibility Check Box

4. The Life-Nonlife Consolidated Taxable Income workpaper is displayed. Navigate to item 7 labeled
Consol. OLD or NOL offset (*).

5. Selectthe linkin the field under the Nonlife subgroup column 2, labeled Nonlife against Life, to take
you to the Consolidated subgroup OLD or NOL Utilized workpaper.

6. Navigate to item 2 labeled Limitation on subgroup losses. Select in the field in the Nonlife subgroup
column for the item labeled Nonlife against Life.

7. The Limitation on Nonlife NOL Utilization per Reg. 1.1502-47(m)(4)(x) worksheet is displayed.

LNL ELIGIBILITY CHECK BOX

Nonlife subgroup net operating losses that occur in a Life Nonlife top consolidation by default are NOT offset
against life subgroup income. There is an election for the Nonlife subgroup NOLs to be eligible against life
subgroup income. In order to have the Nonlife subgroup NOLs (1120 and 1120-PC) be offset against any life
subgroup income, you must select a check box to determine for which year the election should be used. This
check box is located in the Nonlife subgroup, Life subgroup, or Life Nonlife top consolidation.
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Chapter 8: Net Operating Loss
LNL Eligibility Check Box

Navigation: Organizer > Carryovers, Footnotes and Invoicing > Carryovers > Computed Carryback
Detail > Life-nonlife Carryover Detail > Non-SRLY Eligibility Election (globally)

Non-SRLY NOL SRLY NOL 5382 NOL

[[] Check to suppress print of original NOL on carryover schedules

NON-SRLY NOL

*The "Amount Utilized Override” should only be used for consclidated or single returns, if necessary, to present correct utilization.

**The "Parent or Subsidiary Utilization” fields are for members of consolidations to correctly reflect remaining carryovers for print and rollover purposes.
Include any carryback to prior years utilized in the current year utilization.

**We calculate the conversion of contribution carryover to NOL carryover based on total NOL carryover. If you are calculating NOL carryover to next year
for each year separately, enter the amount of NOL converted from contributions in the Organizer Override fields.

Do not use the current year generated amount field on a top consolidation or single company.

[O\-'emt_i.e} ) (Override)™= Parent or NOL Converted from
Year Ending Carryover to Amount Utilized in NOL Converted from Subsidiary Contributions
verride riginal | ontributions tilization arent/Subsidiary
QOverrid Original NOL Contributi Utilization™ Parent/Subsidi

Figure 8:6
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76 Chapter 8: Net Operating Loss

Examples of NOL Utilization

EXAMPLES OF NOL UTILIZATION

NL Examples

NL NOL
1120 SUBGROUP TAX RETURN

TAXABLE INCOME BEFORE NOL

LESS NOL

LESS SPECIAL DEDUCTION

TOTAL NOL AND DEDUCTION

TOTAL NOL AND DEDUCTIONS

1120 SUBGROUP

4,004,000

1120 PARENT

1120 PARENT WITH NON SRLY NOL $5,000

4,004,000

4,000

4,000

4,000

4,000

4,000,000

4,000,000

Comment: The Non-SRLY NOL are utilized in the topcon (see below)

NL CONSOL. WORKSHEET

TAXABLE INCOME BEFORE NOL

LESS NOL

LESS SPECIAL DEDUCTION

THOMSON REUTERS
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NL CONSOL. ADJUSTMENTS 1120 SUBGROUP PC SUBGROUP

6,006,000

4,004,000

2,002,000

5,000

5,000

None

6,000

4,000

2,000




NL CONSOL. WORKSHEET

TOTAL NOL AND DEDUCTION

TOTAL NOL AND DEDUCTIONS

TAXABLE INCOME

NL NOL

1120 SUBGROUP TAX RETURN

TAXABLE INCOME BEFORE

NOL

LESS NOL

LESS SPECIAL DEDUCTION

TOTAL NOL AND DEDUCTION

TOTAL NOL AND DEDUCTIONS

NL CONSOL.

Chapter 8: Net Operating Loss

Examples of NOL Utilization

ADJUSTMENTS 1120 SUBGROUP PC SUBGROUP

77

11,000

5,000

4,000

2,000

5,995,000

(5,000)

4,000,000

2,000,000

1120 PARENT WITH NON-SRLY $5,000, $100 SRLY & $382 SECTION

382 NOL
1120 SUBGROUP 1120 PARENT  ELIM.
4,004,000 4,004,000
482 482
4,000 4,000 0
4,482 4,482 0
3,999,518 3,999,518 0

Comment: The Non-SRLY NOL are utilized in the topcon (see below)
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Examples of NOL Utilization

NL CONSOL. WORKSHEET NL CONSOL. ADJUSTMENTS 1120 SUBGROUP PC SUBGROUP
TAXABLE INCOME BEFORE NOL [RFSIMSNP 4,004,000 2,002,000
LESS NOL 5,482 5,000 482 0
LESS SPECIAL DEDUCTION 6,000 4.000 2,000
TOTAL NOL AND DEDUCTION 4,000 4,000 4.000 0

TOTAL NOL AND DEDUCTIONS 11,482 5,000 4,482 2,000
TAXABLE INCOME 5,094.518 (5,000) 3,999,518 2,000,000

NL NOL 1120 PARENT WITH NON-SRLY $5,000, $100 SRLY & $382 SECTION 382
NOL, AND PC SUBGROUP WITH $1382 SECTION 382 NOL

1120 SUBGROUP TAX 1120 SUBGROUP 1120 PARENT ELIM.
RETURN

TAXABLE INCOME BEFORE

NOL 4,004,000

4,004,000

LESS NOL 482 482

LESS SPECIAL DEDUCTION 4,000 4,000 0

TOTAL NOL AND
DEDUCTION

4,000 4,000 0
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Examples of NOL Utilization

NL NOL 1120 PARENT WITH NON-SRLY $5,000, $100 SRLY & $382 SECTION 382
NOL, AND PC SUBGROUP WITH $1382 SECTION 382 NOL

1120 SUBGROUP TAX 1120 SUBGROUP 1120 PARENT ELIM.
RETURN

TOTAL NOL AND

DEDUCTIONS 3,999,518

3,999,518

Comment: The Non-SRLY NOL are utilized in the topcon (see below)

NL NOL 1120 PARENT WITH NON-SRLY $5,000, $100 SRLY & $382 SECTION 382
NOL, AND PC SUBGROUP WITH $1382 SECTION 382 NOL

1120 SUBGROUP TAX 1120 SUBGROUP 1120 PARENT ELIM.

RETURN

TAXABLE INCOME

BEEORE NOL 2,002,000 2,002,000

LESS NOE 1,382 1,382

LESS SPECIAL

DEDUCTION 2,000 2,000 0

TOTAL NOL AND

DEDUCTION 3,382 3,382 0

TOTAL NOL AND

DEDUCTIONS 1,998,618 1,998,618 0

Comment: The Non-SRLY NOL are utilized in the topcon (see below)
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Examples of NOL Utilization

NL CONSOL. WORKSHEET NL CONSOL. ADJUSTMENTS 1120 SUBGROUP PC SUBGROUP
TAXABLE INCOME BEFORE NOL [ERSNN 4,004,000 2,002,000
LESS NOL 6,864 5,000 482 0
LESS SPECIAL DEDUCTION 6,000 4,000 2,000
TOTAL NOL AND DEDUCTION 4000 4,000 4,000 0

TOTAL NOL AND DEDUCTIONS 12,864 5,000 4,482 3,382
TAXABLE INCOME 5,993,136 (5,000) 3,999,518 1,098,618

LNL Examples

LNL NOL

1120 SUBGROUP
TAX RETURN

1120 SUBGROUP

Ui Gl 4,004,000

1120 PARENT

4,004,000

ELIM.

1120 PARENT WITH $5,000 NON-SRLY, $100 SRLY & $382 SECTION 382 NOL, PC
SUBGROUP WITH $1382 SECTION 382 NOL, AND LIFE SUBGROUP WITH $10,382
SECTION 382 NOL

INCOME BEFORE

NOL

LESS NOL 482 482

LESS SPECIAL 4,000 4,000 0

DEDUCTION
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Examples of NOL Utilization

LNL NOL 1120 PARENT WITH $5,000 NON-SRLY, $100 SRLY & $382 SECTION 382 NOL, PC
SUBGROUP WITH $1382 SECTION 382 NOL, AND LIFE SUBGROUP WITH $10,382
SECTION 382 NOL

1120 SUBGROUP 1120 SUBGROUP 1120 PARENT ELIM.
TAX RETURN

TOTAL NOL AND
DEDUCTION

TOTAL NOL AND
DEDUCTIONS

3,999,518 3,999,518

Comment: The Non-SRLY NOL are utilized in the topcon (see below)

LNL NOL 1120 PARENT WITH $5,000 NON-SRLY, $100 SRLY & $382 SECTION 382 NOL, PC
SUBGROUP WITH $1382 SECTION 382 NOL, AND LIFE SUBGROUP WITH $10,382
SECTION 382 NOL

PC SUBGROUP PC SUBGROUP PC PARENT PC ELIM.
TAX RETURN

TAXABLE
INCOME BEFORE
NOL

2,002,000 2,002,000

Lasmldel 1,382 1,382

LESS SPECIAL

DEDUCTION 2,000 2,000 0

TOTAL NOL AND

DEDUCTION 3,382 3,382 0

TOTAL NOL AND

DEDUCTIONS 1,998,618 1,998,618 0

Comment: The Non-SRLY NOL are utilized in the topcon (see below)
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Examples of NOL Utilization

LNL NOL

1120 PARENT WITH $5,000 NON-SRLY, $100 SRLY & $382 SECTION 382 NOL, PC
SUBGROUP WITH $1382 SECTION 382 NOL, AND LIFE SUBGROUP WITH $10,382

SECTION 382 NOL

LIFE SUBGROUP
TAX RETURN

LIFE SUBGROUP

TAXABLE
INCOME BEFORE
NOL

1,001,000

LIFE PARENT

1,001,000

LIFE ELIM.

LESS NOL 10,382

10,382

LESS SPECIAL

DEDUCTION 1,000

1,000

TOTAL NOL AND

DEDUCTION 11,382

11,382

TOTAL NOL AND

DEDUCTIONS 989,618

989,618

Comment: The Non-SRLY NOL are utilized in the topcon (see below)

LNL CONSOL.
WORKSHEET

LNL
CONSOL.

TAXABLE INCOME

BEFORE NOL 7,007,000

ADJUSTMENTS 1120
SUBGROUP

4,004,000

PC
SUBGROUP

2,002,000

LIFE
SUBGROUP

1,001,000

LESS NOL 17,246

5,000

482

1,382

10,382

LESS SPECIAL
DEDUCTION

6,000

4,000

2,000

1,000
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Common NOL Support Questions

LNL CONSOL. LNL ADJUSTMENTS 1120 PC LIFE
WORKSHEET CONSOL. SUBGROUP SUBGROUP SUBGROUP

TOTAL NOL AND
DEDUCTION

83

TOTAL NOL AND

DEDUCTIONS 24,246

4,482 3,382

11,382

Lttt Sl 50, 12 6,982,754 (5000) | 3999518 | 1,998,618 989,618

COMMON NOL SUPPORT QUESTIONS

Q: How do | suppress the NOL carryover statement from printing for the sub members?

A: Navigate to Organizer > Consolidated Returns > Step 3 > Form Print Options. Select the check box
to suppress 1120 on the Page 1 NOL detail for both parent and all subsidiaries.

Q: How do | print the NOL statement? The statement is not printing correctly.

A: Depending on the type of NOL (there are three types), utilization and print of Non- SRLY NOL are at the
topcon level. If NOLs have been entered, check if overrides are entered used in the Organizer.

Q: How do | print the NOL SRLY NOL schedule? It is not printing on the form.

A: The utilization and print of Non-SRLY NOL is at the topcon level. If the non-SRLY NOL schedule is not
printing on the form, enter NONE if no amount is present (if applicable).

Q: Do the federal NOL amounts flow to the states schedules?

A: Yes, they flow automatically from the federal area to the states.
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Common NOL Support Questions

Q: How do | correct the S382 NOL? The S382 NOL is not flowing to the topcon and/or not utilizing
the correct amount.

A: For S382 NOLs, the limited amount in the Organizer must also be entered. Navigate to Organizer >
Carryovers, Footnotes, and Invoicing > Carryovers > Computed Carryover Detail > Carryover
Detail > Regular NOL > S 382 NOL tab

Q: Why is the NOL not being limited by income?

A: Navigate to Organizer > Income and Deductions > Deductions > Detail, and clear the check box
labeled Unlimited NOL computations.

Q: Where can | override my NOL?

A: First check if entry of NOL is correct in lowest level (parent or subsidiary) and not in the topcon level.
Overrides should be entered in Organizer > Income and Deductions > Deductions. Choose the type of
NOL field to override.

Q: Where is the check box to allow unlimited NOL computations?

A: Navigate to Organizer > Income and Deductions > Deductions, and locate the NOL section.
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CHAPTER 9: CONSOLIDATING THE
RETURN

PREPARING FOR CONSOLIDATION

Before beginning any consolidations, all individual company returns should be completed and balanced.
Ensure that the return/entity type is marked correctly in each return. All of the components for the consolidation
must be prepared before beginning the consolidation process, which includes entering the company data in the
1120, 1120-PC, and 1120-L tax returns. If states are to be consolidated, the particular states to be consolidated
must be activated in every return in the consolidation (even if it is not filed by a particular company) in the state
Organizer Add/Delete screen.

ELIMINATION RETURN

Every consolidation group must have an elimination return. All inter-company transactions to be eliminated for
tax purposes are entered in the elimination return.

Nonlife eliminating entries can be entered using the same 1120 subgroup's Income/Deductions and Schedule
M-3 screens.

A subgroup elimination return can be converted to a nonlife elimination return. (See Step 3: Choose
Return/Entity Type (page 43) for more information on changing entity types.) All entries made will be
automatically transferred from the subgroup elimination company to the Nonlife eliminations company.

D* Elimination entries are made at the Nonlife and subgroup company level. The software does not
support elimination adjustments at the Life-Nonlife level.

Types of Elimination Returns
o LNL topcon elimination
o NL elimination

« Subgroup eliminations.
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Elimination Return

NONLIFE ELIMINATION

The Nonlife return has an elimination company in which intercompany entries can be made between the 1120
and the 1120-PC returns. These elimination entries are made in the NL elimination entry screens. There are
limited data entry fields in the Nonlife elimination return. The Nonlife elimination return is not included in the e-
file sentto the IRS, but it does consolidate to the top level consolidation.

INSURANCE CONSOLIDATIONS STEP 2 - ELIMINATING ENTRIES

In the Nonlife Elimination Organizer, you have to choose the proper return entity tab to enter data, 1120 or
1120-PC. The following screens have fields available to enter data:

o 1120 Income & Deductions

« 1120 Balance Sheet (beginning and ending balances)

e 1120 M-1 &M-2

e 1120 M-3 Part Il &I

e 1120-PC Income & Deductions

« 1120-PC Balance Sheet (beginning and ending balances)
e 1120-PC M-1 & M-2

e 1120-PC M-3 Part Il &1l

SUBGROUP ELIMINATION

Each subgroup Subconsolidation has its own subgroup Elimination return. The elimination return type matches
the subgroup return type 1120, 1120-L or 1120-PC. Subgroup elimination returns are there to make the
intercompany and elimination entries for the subgroup.

| D/’ Only the topmost subgroup Elimination of each return type is included in the e-file.
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Subgroup Consolidation

SUBGROUP CONSOLIDATION

1120 Subgroup Subconsolidation

The topmost 1120 subgroup Consolidation is consolidated in a Nonlife subgroup or top consolidation (topcon)
and is then included in the e-file. You can have many lower 1120 subgroups included (there is no limit) in the
topmost 1120 subgroup, but they are not included in the e-file. Only the one topmost 1120 subgroup is allowed
in e-file. All entities in the What to Consolidate listing must be of the 1120 return type. Do not mix entity types
within a subgroup.

Types of 1120 Subgroup Subconsolidations

The 1120 subgroup can have any of the following structures.

If the entities share the same tax ID number, create a Divcon. The returns listed are divisions. The tax ID is on
the Divcon.

DIVCON RETURN

PARENT SLOT Division

ELIMINATION SLOT Subgroup Elimination

SUBSIDIARY SLOT Division

If there are several 1120 subsidiaries and 1120 subgroups to be consolidated together:

1120 SUBGROUP

PARENT SLOT 1120 Subsidiary or Subgroup

ELIMINATION SLOT 1120 Subgroup Elimination

SUBSIDIARY SLOT(S) 1120 Subsidiary or Subgroup

If there are several 1120 subsidiaries to be consolidated together:

1120 SUBGROUP

PARENT SLOT 1120 Subsidiary
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Subgroup Consolidation

1120 SUBGROUP

ELIMINATION SLOT 1120 Subgroup Elimination

SUBSIDIARY SLOT(S) 1120 Subsidiary

If there is ONLY one 1120 subsidiary in the entire consolidation:

1120 SUBGROUP

PARENT SLOT 1120 Subsidiary

ELIMINATION SLOT 1120 Subgroup Elimination

SUBSIDIARY SLOT

Steps to Complete an 1120 Topmost Subgroup
1. Create the 1120 topmost 1120 subgroup return.

2. Goto Organizer > Insurance Consolidations > 1120 Subgroup Consolidation Wizard > Step 2 -
What to Consolidate.

3. Enter the applicable parent, elimination, and subsidiaries according to the above structures.

4. Compute all subsidiaries if necessary. If you make any changes to the lower entities, you must recompute
them and reconsolidate.

5. Consolidate.

1120-PC Subgroup Subconsolidation

ALL 1120-PC returns must be combined in an 1120-PC Subgroup Consolidation. Even if there is only ONE
1120-PC individual company in the entire consolidation, a subgroup is required.

The topmost 1120-PC Subgroup Consolidation is consolidated into a Nonlife subgroup or top consolidation.
You can have many lower 1120-PC subgroups included (there is no limit) in the topmost 1120-PC subgroup,
but they are notincluded in the e-file per the IRS schema rules. Only the one topmost 1120-PC subgroup is
allowed in the e-file. All entities in the What to Consolidate listing must be of the 1120-PC-type of return. Do
not mix entity types in a subgroup subconsolidation.
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Subgroup Consolidation

Types of 1120-PC Subgroup Subconsolidations
The 1120-PC subgroup can have the following three examples in the What to Consolidate listing.

D/* If your parent is in this group and a 1120-PC, your NL or LNL top consolidation must be a 1120-PC
- and is not allowed to e-file yet.

If there are several 1120-PC subsidiaries and/or subgroups to be consolidated together:

1120-PC SUBGROUP

PARENT SLOT 1120-PC Subsidiary or Subgroup

ELIMINATION SLOT 1120 Subgroup Elimination

SUBSIDIARY SLOT(S) 1120-PC Subsidiary/or Subgroup

If there are several 1120-PC subsidiaries to be consolidated together:

1120-PC SUBGROUP

PARENT SLOT 1120 PC Subsidiary

ELIMINATION SLOT 1120 PC Subgroup Elimination

SUBSIDIARY SLOT(S) 1120 PC Subsidiary

If there is ONLY one 1120-PC subsidiary in the entire consolidation:

1120-PC SUBGROUP

PARENT SLOT 1120-PC Subsidiary

SR TSR B Hea ik PIN 1120-PC Subgroup Elimination

SUBSIDIARY SLOT Blank
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Subgroup Consolidation

Steps to Complete an 1120-PC Topmost Subgroup
1. Create the 1120-PC topmost 1120 subgroup return.

2. Goto Organizer > Insurance Consolidations > 1120-PC subgroup Consolidation Wizard > Step
3 - What to Consolidate.

3. Enter the applicable parent, elimination, and subsidiaries according to the above structures.

4. Compute all subsidiaries if necessary. If you make any changes to the lower entities, you must recompute
and reconsolidate.

5. Consolidate.

1120-L Subgroup Subconsolidation

ALL 1120-L returns must be combined in an 1120-L subgroup Consolidation. Even if there is only ONE
1120-L individual company in the entire consolidation, a subgroup is required for the tax product.
The topmost 1120-L subgroup consolidation is consolidated with a Nonlife subgroup into the Life Nonlife
topcon. You can have many lower 1120-L subgroups included (there is no limit) in the topmost 1120-L
subgroup, but they are not in the e-file. Only the topmost 1120-L subgroup is allowed in the e-file. All entities in
the What to Consolidate listing must be of the 1120-L return type. Do not mix entity types.

Types of 1120-L Subgroup Subconsolidation Structures

The 1120-L subgroup can have any of the following structures. If your parent is in this group and is an 1120-L
return type, then your LNL top consolidation must be an 1120-L return type and is not allowed to e-file yet.

If the entities share the same tax ID number, create a Divcon. The returns listed are Divisions. This is the
case for the Life Annual Statement return and the Separate Accounts statement because they usually share the
same tax ID number. The tax ID is on the Divcon.

DIVCON RETURN

PARENT SLOT Division

ELIMINATION SLOT Subgroup Elimination

SUBSIDIARY SLOT Division
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Subgroup Consolidation

If there are several 1120-L subsidiaries and 1120-L subgroups to be consolidated together:

1120-L SUBGROUP

PARENT SLOT 1120-L Subsidiary or Subgroup

ELIMINATION SLOT 1120-L Subgroup Elimination

SUBSIDIARY SLOT(S) 1120-L Subsidiary or Subgroup

If there are several 1120-L subsidiaries to be consolidated together:

1120-L SUBGROUP

PARENT SLOT 1120-L Subsidiary

ELIMINATION SLOT 1120-L Subgroup Elimination

SUBSIDIARY SLOT(S) 1120-L Subsidiary

If there is ONLY one 1120-L subsidiary in the entire consolidation:

1120-L SUBGROUP

PARENT SLOT 1120-L Subsidiary

ELIMINATION SLOT 1120-L Subgroup Elimination

SUBSIDIARY SLOT Blank

Steps to Complete an 1120-L Topmost Subgroup
1. Create the 1120-L topmost 1120-L subgroup return.

2. Goto Organizer > Insurance Consolidations > 1120-L subgroup Consolidation Wizard > Step 3
- What to Consolidate.

3. Enter the applicable parent, elimination, and subsidiaries according to the above structures.

4. Compute all subsidiaries if necessary. If you make any changes to the lower entities, you must recompute
and reconsolidate.

5. Consolidate.
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Nonlife Consolidation

Subgroup Top Consolidation

Thisis NOT a Mixed Group filing. This consolidation contains entities that are all of one type of return. If multiple
1120-PCs (and no 1120 or 1120-L returns) file to the IRS together, your top consolidation is an 1120-PC
subgroup top consolidation. If multiple 1120-Ls (and no 1120 or 1120-PC returns) file to the IRS together, your
top consolidation is an 1120-L subgroup top consolidation.

While this return resembles a subgroup Subconsolidation, it is an Insurance top consolidation that can file to the
IRS by printonly. The IRS does not yet accept e-file for this return type.

Types of Subgroup Top Consolidation Structures
These are the following possible structures for a subgroup top consolidation.

If all entities in the consolidation are 1120-PCs, then the example would be:

PARENT SLOT 1120-PC Subgroup/Parent

ELIMINATION SLOT 1120-PC Elimination

SUBSIDIARY SLOT 1120-PC Subgroup/Parent

If all entities in the consolidation are 1120-Ls, then the example would be:

PARENT SLOT 1120-L Subgroup/Parent

ELIMINATION SLOT 1120-L Elimination

SUBSIDIARY SLOT 1120-L Subgroup/Parent

NONLIFE CONSOLIDATION

A mixed group consolidation that consists of 1120 and 1120-PC returns ONLY is a Nonlife Consolidation. It
cannot contain any other return type. If you have other subsidiaries in your company structure, they must be
combined in the subgroups. The IRS rules designate that an 1120 subgroup return and an 1120-PC subgroup
return consolidate together. Return types must be grouped together.

Only the following Nonlife Structures correctly compute, print, and create an e-file in the tax application. If you
are creating a Nonlife subgroup to be further consolidated with a Life subgroup into a Life Nonlife top
consolidation, you must set up the structure correctly.
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Nonlife Consolidation

Nonlife Subgroup or Nonlife Top Consolidation

The Nonlife consolidation can ONLY contain THREE entities on the Subsidiary Listing (see below) of the What
to Consolidate listing. The structures are the same for the Nonlife subgroup and the Nonlife top consolidation.
There are only two structures for a Nonlife subgroup or Nonlife top consolidation.

Types of Nonlife Structures

The Nonlife consolidation can ONLY contain THREE entities. The structures are the same for the Nonlife
subgroup and the Nonlife top consolidation. The Nonlife can have the following examples:

If the parent is an 1120, the example would be:

93

PARENT SLOT 1120 Topmost Subgroup

ELIMINATION SLOT 1120 Nonlife Elimination

SUBSIDIARY SLOT 1120-PC Topmost Subgroup

If the parentis an 1120-PC, then the example would be:

PARENT SLOT 1120-PC Topmost Subgroup

ELIMINATION SLOT 1120-PC Nonlife Elimination

SUBSIDIARY SLOT 1120 Topmost Subgroup

Complete the What to Consolidate Subsidiary listing with all 1120-L entities.

If the Nonlife subgroup (to be consolidated in a LNL top consolidation) has only an 1120-PC subgroup return
and no 1120 subgroup, then the example would be:

PARENT SLOT 1120 Topmost Subgroup

ELIMINATION SLOT 1120 -PC Subgroup Elimination

SUBSIDIARY SLOT BLANK
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Life Nonlife Consolidation

Steps to Complete a Nonlife Return
1. Create the Nonlife top consolidation or subgroup return.

2. Goto Organizer > Insurance Consolidations > Nonlife Consolidation Wizard > Step 2 - What to
Consolidate.

3. Enter the applicable parent, elimination, and subsidiaries according to the above structures.

4. Compute all subsidiaries if necessary. If you make any changes to the lower entities, you must recompute
and reconsolidate.

5. Consolidate.

Consolidation Review

After consolidation, you can review the results and verify the company’s taxable income on this screen. It lists
each entity, return type, and taxable income. Only parent, subsidiary, and elimination returns transfer;
subgroup subconsolidation returns do not transfer.

LIFE NONLIFE CONSOLIDATION

A mixed group consolidation that consists of 1120, 1120-PC, and 1120-L returns is a Life Nonlife Consolidation.
It cannot contain any other return type. If you have other subsidiaries in your company structure, they must be
combined in one of the three subgroups. Return types must be grouped together.

Only the following Life Nonlife Structures correctly compute, print, and e-file in the tax application.

Types of Life Nonlife Structures

The Life Nonlife consolidation can ONLY contain THREE entities. The Life Nonlife can have the following
examples.

If the parentis an 1120, then the example would be:

PARENT SLOT 1120 Nonlife Subgroup

ELIMINATION SLOT 1120 LNL Elimination

SUBSIDIARY SLOT 1120-L Topmost Subgroup

THOMSON REUTERS
1120 INSURANCE GUIDE



Chapter 9: Consolidating the Return 95

Tools for Consolidation

If the parentis an 1120-PC, then the example would be:

PARENT SLOT 1120-PC Nonlife Subgroup

ELIMINATION SLOT 1120-PC Elimination

SUBSIDIARY SLOT 1120-L Topmost Subgroup

If the parentis an 1120-L, then the example would be:

PARENT SLOT 1120-L Nonlife Subgroup

ELIMINATION SLOT 1120 Elimination

SUBSIDIARY SLOT 1120 or 1120-PC Topmost Subgroup

If the Nonlife subgroup does not include a PC subgroup:

You MUST create a PC subgroup that includes a blank PC subsidiary and blank PC elimination. This is then
consolidated with the 1120 subgroup in the Nonlife subgroup Subconsolidation. If the PC subgroup is omitted,
the result in a nonqualified XML file.

TOOLS FOR CONSOLIDATION

Subview

Subview has been modified to go directly to the lower entities.

Subview gives easier access to the members of consolidated returns and is used for reconciliation of
consolidated returns. In any consolidated return, select any field and select Subview to view the entities,
amounts, and adjustments, if any, that make up that consolidated number. A dialog box then shows you entities
that consolidate to the current field. To see a specific entity, highlight or select the item, and the screen jumps to
that entity, while still maintaining the consolidation.

THOMSON REUTERS
1120 INSURANCE GUIDE



96 Chapter 9: Consolidating the Return
Form 851: Corporate Affiliations Schedule

Through the Windows option at the top of the screen, you can choose entities you have opened using
Subview. When you are finished with a particular entity, close it using the red Xin the upper left corner below
the file option. After using Subview, you must complete the consolidation as usual at each consolidated level if
any changes were made to any entity in that consolidation.

SubView - 1120PC Locator For Consol —

Company No Company Name Return Amount -
] 1| 1120PC Locator For Consol 4153.B |

P 1120PC Locator_Parent 4165.B

g 1120PC Locator Subs 1 4155.8

8 1120PC Locator_Sub 2 4159JB E—

E 1120PC Elims Test Locator 4163JB

Total from subsidiaries of selected retumn 0

Adjustment

Total on selected return 0
Figure 9:1

Schedule K Questions

The software pulls Schedule Kinformation from the parent company. On a Nonlife or Life-Nonlife return, this
information comes from the subgroup Schedule K that contains the parent company.

FORM 851: CORPORATE AFFILIATIONS SCHEDULE

Preparing Form 851

Form 851 is printed from the top consolidation return, but consists of information entered in the parent and
subsidiary returns. To create the 851 correctly, it is important to know where to enter information for each field
and section of the form. These instructions lead you through that process.
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Form 851: Corporate Affiliations Schedule

Generally, information for the 851 comes from these three places: the top consolidation return, the parent
return, and the subsidiary returns. When you create a consolidation return, select the active members to be
included in the consolidation on the What to Consolidate screen. The program can now transfer in certain
information from the entities you have listed. The corporation name, address, FEIN, estimated and extension
payments, Principal Business Activity, and PBA code information is carried in from the General Information
area in the respective parent and subsidiary returns.

Consolidation Carry Information

We call the information that transfers into the top consolidation from other returns consolidation carry
information. Every time you perform a consolidation, the program sweeps the parent and subsidiary returns to
collect the Consolidation Carry Information.

AD Be careful not to enter any of this information in the top consolidation’s Organizer or Tax Forms. If
you manually enter any data in these fields, the application overwrites this information each time
you consolidate, when it transfers the Consolidation Carry Information into the Organizer.

First we look at what information comes from which return, and then go through the form field-by-field, and list
the source for the data. In general, the following information transfers from the returns shown.

Parent

The following information carries automatically to the top consolidation return from the parent. To have this
transfer take place, you must enter the company locator numbers on the top consolidation return in Organizer
> Consolidated Returns > What to Consolidate screen.

« Name and address (street, city, state, zip code)

Tax year ending

Employer identification number

Prepayment credits

o PBA (Principal Business Activity) Code number.
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Form 851: Corporate Affiliations Schedule

Subsidiaries
The following information carries automatically to the top consolidation return from the subsidiary returns:

Names and addresses

Employer identification numbers

Prepayment credits

« Principal business activity

PBA code numbers.

Top Consolidation

Enter the following information in the top consolidation return:

Inactive Subsidiary Information

If you do not prepare returns for inactive members of the consolidation, you can add these members to your
Form 851 on the top consolidation return. This information carries to Part | of the Form 851 tax return.

1. In the top consolidation return, access Organizer > Informational Forms > Affiliation Schedule >
Inactive Subsidiary Information.

2. Enter the name, address, FEIN, and PBA information for each inactive member company.

3. Be sure to assign the first inactive subsidiary a company number that follows the last number assigned to
active subsidiaries on the Consolidated Returns > What to Consolidate > Consolidation Locator
List screen.

Voting Stock Information

Enter your company number, the PBA activity, and the code appears.

Part lll and Part IV Information

Enter Parent and Subsidiary information for Parts Il and IV of Form 851.

Entering Information for Form 851
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Form 851: Corporate Affiliations Schedule

Part |
For Part I, the following tables indicate where information is entered.

Page 1, top section: General Information

FORM 851 ITEM WHERE TO ENTER IN ORGANIZER

IN THE PARENT RETURN

Common Parent corporation General Information > Basic Return Information > Entity
name Information tab
Address General Information > Basic Return Information > Entity

Information tab

FEIN General Information > Basic Return Information > Entity
Information tab

Tax year end General Information > Basic Return Information > Entity
Information tab

For Part |, the following shows where information is entered.

FORM 851 ITEM WHERE TO ENTER IN ORGANIZER

IN THE TOP CONSOLIDATION RETURN

Company Number Consolidated Returns > What to Consolidate

Portion of Form 7004 tax deposits Payments and Extensions > Payment of Taxes

Portion of estimated tax credits and Payments and Extensions > Payment of Taxes

deposits

Name and address of corporation General Information > Basic Return Information > Entity

Information tab

Employer identification number General Information > Basic Return Information > Entity
Information tab
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Form 851: Corporate Affiliations Schedule

FORM 851 ITEM WHERE TO ENTER IN ORGANIZER

Portion of Form 7004 tax deposits Payments and Extensions > Payment of Taxes
Portion of estimated tax credits and Payments and Extensions > Payment of Taxes
deposits

D/‘ If you enter payments on Form 851 in the top consolidation return, these amounts override the
carry information.

FORM 851 ITEM WHERE TO ENTER IN ORGANIZER

IN THE TOP CONSOLIDATION RETURN

Company Number(s) Informational Forms > Affiliations Schedule > 851
Page 1

Did the subsidiary make any non dividend Informational Forms > Affiliations Schedule > 851

distributions? Page 1

Stock holdings at beginning of year Informational Forms > Affiliations Schedule > 851
Page 1

Number of shares

Percent of voting power
Percent of value

Owned by corporation number
PBA Code Number General Information > Questions

IN SUBSIDIARY RETURNS

Principal business activity (PBA) General Information > Questions

PBA Code No. General Information > Questions

THOMSON REUTERS
1120 INSURANCE GUIDE



Chapter 9: Consolidating the Return 101

Form 851: Corporate Affiliations Schedule

Part lll: Changes in Stock Holdings During the Year

You are not required to complete Part lll for all members of the affiliated group. Therefore, we default to leaving
this part blank. If the affiliated group has members who must complete Part I, enter the following information to

the Organizer screens:

FORM 851 ITEM

IN THE TOP CONSOLIDATION RETURN

WHERE TO ENTER IN ORGANIZER

Company Number(s)

Informational Forms > Affiliations
Schedule > 851 Page 2

Stockholder (Corporation No.)

Informational Forms > Affiliations
Schedule > 851 Page 2

Change in stock holdings during the year
Date

(a) Changes
Shares Acquired
Shares Disposed of

(b) Shares held after changes described in Column (a)
Percent of voting power
Percent of value

Informational Forms > Affiliations
Schedule > 851 Page 2

If the equitable owners of any capital stock shown above were
other than the holders of record, give full details

Informational Forms > Affiliations
Schedule > 851 Page 2
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Form 851: Corporate Affiliations Schedule

Part IV: Additional Information

You are not required to complete Part IV for all members of the affiliated group. Therefore, we default to leaving
this part blank. If the affiliated group has members who must complete Part 1V, enter the following information
on the Organizer screens:

FORM 851 ITEM WHERE TO ENTER IN ORGANIZER

IN THE TOP CONSOLIDATION RETURN

Question 1 Informational Forms > Affiliations
Schedule > 851 Page 3

Company number(s)
Answer to Question 1

If yes, list and describe each class of stock

Question 2 Informational Forms > Affiliations
Schedule > 851 Page 3

Company number(s)
Answer to Question 2

If yes for any part of question 2, list and explain the

circumstances

Question 3 Informational Forms > Affiliations
Schedule > 851 Page 3

Company number(s)

Answer to Question 3
Iltem 3a, 3b, 3¢

Item 3d — description of arrangements
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Form 851: Corporate Affiliations Schedule

Printing Form 851

Form 851 has been changed to print only on the top consolidation; it does not print on the subgroup, subcon, or
divcon.

The system does not transfer Part Il and IV information from members. This information must be entered on
the top consolidation.

Part Il

851, Page 1 851, Page 2 851, Page 3

CHANGES IN STOCK HOLDINGS DURING THE TAX YEAR

Enter the information on the consolidated return, not on the parent or subsidiaries.

Enter only one line for each company for e-file.

(a) Changes (b} Shares held after changes
Corp.  Stockholder Mo. of Shares  No. of Shares *Percent of *Percent
No. No. Date Acquired Disposed of Voting Power  of Value
|
~
W

Figure 9:2
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Form 851: Corporate Affiliations Schedule

Part IV

Organizer Tax Forms Collapse All -] 851, Page 1 851, Page 2 851, Page 3

» [ salvage and Subrogation ~
PART IV - QUESTION 1
» [ Deferred Acquisition Costs

During the tax year, did the corporation have more than one clazs of stock outstanding?
» [3 Amended Return

Oves ®No O Leave Blank
» [ Income and Deductions

If "fes," enter the name of the corporation and list and describe each class of stock.
» [ Gains and Losses

b [ Taxes Corp. No. Clazs of Stock

» [ cCredits ~
¥ [O Payments and Extension

» [ Estimates and Penalties

» [ Letters and Filing Instructions

I* [ Infermational Forms

~ [ Affiliation Schedule S < SIS

851
Part Il Enter on the sub (Multi-ti During the tax year, was there any member of the consoclidated group that reaffilisted
art Il Enter on the sub (Mult-tier) within 60 months of disaffliation?
» [ Inactive Subsidiary Information
Oves ®No O Leave Blank

» [J General Dependency Attachment
If "fes," enter the name of the corporation(s) and explain the circumstances.

-

[ Application to Use LIFO Method

b [ Asset Acquisition Corp. No. Explanation

b [ asset Allocation Statement ~
» [3 Authorization to be Included

» [ Conzent Dividend v

-

[ Change in Accounting Method

-

[ Change of Address

-

[ Distlosure Statemant
PART IV - QUESTIONS 3

-

[ Dissolution or Liquidation

During the tax year, was there any arrangement in exiztence by which one or mere

persons that were not members of the affiliated group could acquire any stock, or

[ Election Under Section 338 acquire any voling power without acquiring stock, in the corporation, other than a
de minimis amount, from the corporation or another member of the affiliated group?

-

[ Election by & Small Business Corporatio

-

-

[ Election to Have Other Tax Year

» [ Employer-Owned Life Ins Contract Oves ®No O LeaveBlank
b [ Entity Classification Elsction (v} If "Yes," enter the name of the corporation and see the instructions for what to enter in items 3a, 3b,
3¢, and 3d.

Figure 9:3
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CHAPTER 10: MIXED GROUP STATE
CONSOLIDATION

There are two different structures of setting up a mixed group state consolidation return:
o multitier structure

« single tier or flat consolidation structure

MULTI-TIER MIXED GROUP STATE CONSOLIDATION
STRUCTURES

Similar to the federal mixed group consolidation, this structure includes a topmost 1120 subgroup, a topmost
1120-PC subgroup, and if applicable, a topmost 1120-L subgroup. The 1120 topmost subgroup is consolidated
with the 1120-PC onto a nonlife topcon (or subcon if there is an 1120-L subgroup in the consolidation). Then, if
applicable, the nonlife subgroup is consolidated with the topmost 1120-L subgroup into a life-nonlife
consolidation.

1120/1120-PC/1120-L Life-Nanlife

Life-Nonlife Eliminations 1120/1120-PC Nonlife | 1120-L Topmost
| Subgroup
| | |
Nonlife 1120 Topmost | M20-PC Topmost L {  1120-L Parent
Elimination [ Subgroup Subgroup
—{ 1120-L Subsidiary
— 1120 Parent —| 1120-PC Parent
1120-L Subgroup
| 1120 Subsidiary | 1120-PC Subsidiary o Eliminations
1120 Subgroup || 1120-PC Subgroup
|  Eliminations Eliminations

Figure 10:1
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Single-Tier or Flat Mixed Group State Consolidation Structure

SINGLE-TIER OR FLAT MIXED GROUP STATE
CONSOLIDATION STRUCTURE

This structure should be used only for mixed group state consolidation returns. The state combined includes
one nonlife top consolidation, one nonlife elimination, and all underlying 1120, 1120-PC, and 1120-L
companies. There should be no mid-level subgroup subconsolidations with this structure. This state combined
allows every underlying company to be shown on the top consolidation return. It is designed to be used for
states, such as lllinois and California.

« lllinois requires every underlying company to be shown on its Schedule UB.

« The California form requires that both the income and deductions be shown for every underlying
company.

This structure should also be used for those states that do not allow subgroup subconsolidations.

1120/1120-PC Nonlife Topcon

Nanlife 1120/11120-PC 1120 1120-PC 1120-L 1120/
Elimination Parent Subsidiary Subsidiary Subsidiary 1120-PC/
1120-L
Divcon
Figure 10:2

NONLIFE ELIMINATIONS

For the 2012 tax year and after, a subgroup elimination return can be converted to a nonlife elimination return.
This is beneficial to those who had eliminating entries entered on their subgroup eliminations for the federal
return. However, for single-tier mixed group state consolidation, since there are no mid-level subgroup
subconsolidations, the subgroup elimination returns cannot be used. Now, the subgroup elimination returns
can be converted using this feature into the nonlife elimination return, and all existing subgroup eliminating
entries are then transferred to nonlife elimination return.

Also, starting with 2012, both 1120 and 1120-PC subgroup elimination returns can be combined into one
nonlife elimination return. This is beneficial to those who had eliminating entries on both 1120 and 1120-PC
subgroup eliminations for the federal return. This feature combines all 1120 and 1120-PC eliminating entries
into one set of entries on the non-life elimination return.
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E-filing

BEST PRACTICE FOR CONVERSIONS

Best practice for the conversion is to make a copy of the subgroup elimination return. If the parentis an 1120
company, then the 1120 subgroup elimination return should be copied. If the parentis an 1120-PC company,
then the 1120-PC subgroup elimination return should be copied.

After copying, the return can be converted to a nonlife eliminations by selecting the appropriate button, 1120-
Non-life Eliminations or 1120PC-Non-life Eliminations. These buttons are found on Organizer >
General Information > Basic Return Information > Return/Entity Type Conversion tab.

E-FILING

A PDF copy of the federal return can be obtained and attached to the mixed group state consolidation return.
There are two copy options: one is to copy the federal return directly from the mixed group state consolidation
itself. The other option is to copy the federal return from a different return. The latter option should be chosen
for a mixed group state combined return that uses the single-tier structure, since it is not federally compliant.

» [J Credits - & C g 2 3 i d
» [3 Payments and Extension 1 ACTIVATIONGONSOLDATION | RETURNTYPE  ENTITY TYPE FINANCIALRETURN  SUPPRESS | pereTe
» [J Estimates and Penalties
2 |FEDERAL ‘ Combine All States 1120 Top consolidation
» O Balance Sheet/M1-M2-M3 3 |ALLOCATION & APPORTIONMENT |(None selected) Delete
- . 4 ALABAMA (None selected) 1120 Top consolidation [l 1 Delete
> [ Letiers and Filing Instructions 5 ALASKA (None selected) 1120 Top consalidation 0 Delete
» [J Current-Year to Prior-Year Comparison 6 |ARIZONA (None selected) 1120 Top consolidation 1 Delete
7 ARKANSAS (None selected) 1120 Top consolidation 1 Delete
» [ Informational Forms & CALIFORNIA (None selected) 1120 Top consolidation 1 Delete
. ) 9 COLORADO (None selected) 1120 Top consolidation 1 Delete
* [ Foreign Information 10 |CONNECTICUT (None selected) 1120 Top consolidation ] Delete
» [ Carryovers, Footnotes, and Invoicing 11 DELAWARE (None selected) 1120 2 O Delete
13 |DISTRICT OF COLUMBIA (None selected) 1120 Top consolidation O Delete
» [ Federal Tax Elections 14 FLORIDA (None selected) 1120 Top consolidation O Delete
15 GEORGIA (None selected) 1120 Top consolidation  (None selected) O Delete
~ [0 States 16 HAWAI (None selected) 1120 Top consolidation O O Delete
~ N 17 |IDAHO (None selected) 1120 Top consolidation O Delete
~ [ State and City Activation/Consolidation ‘ 18 ILLINOIS (None selected) 1120 Top consolidation O Delete
State and City Activation/Consolidation 19  INDIANA (None selected) 1120 Top consolidation O O Delete
21 IOWA (None selected) 1120 Top consolidation O O Delete
Kentucky Common Form Cities 23 |KANSAS (None selected) 1120 Top consolidation O Delete
. 7 24 KENTUCKY (None selected) 1120 Top consolidation O O Delete
Michigan Cities 25 LOUISIANA (None selected) 1120 O Delste
Ohio Cities 27 |MAINE (Mone selected) 1120 Top consolidation O Delete
28 MARYLAND (None selected) 1120 O Delete
DIF Import Ohio City Codes 29 |MASSACHUSETTS (None selected) 1120 Top consolidation O O Delete
30 MICHIGAN (Mone selected) 1120 Top consolidation | (None selected) O Delete
* [ Common State 31 MINNESOTA (MNone selected) 1120 Top consolidation O Delete
» [J General Information 32 MISSISSIPPI (Mone selected) 1120 Top consolidation O Delete
33 MISSOURI (Mone selected) 1120 Top consolidation | (None selected) O Delete
Minimurm Tax Suppression 34 MONTANA (Mone selected) 1120 Top consolidation O Delete
P - . P . - [ — — _—

Figure 10:3
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CHAPTER 11: PRINTING THE RETURN

PRINT

1. Select Print on the Organizer toolbar.

| 120 | Morgan Corp. X

& Compute ~ | & Primt | @ View ~ + > @ History ~ {5 Resources ~ © Help -

Organizer Tax Forms Coliapse All[E]

New Features. Al

QuickTrack ‘
QuickForm
+ [ General Information

» [ Federal Efile v

Figure 11:1
2. The Print Selection screen opens a new window. Within this screen you can:
« Verify the return type to print
o Select desired copy types
o Include e-file attachments
o Selectthe all returns, or portions of the return to print
o Enter afile name
o Create the printfile

« Review previous print history for the return
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109 Chapter 11: Printing the Return
Print

3. Select the returns you wish to print.

» 10 A~

All Returns
Federal Return
All State & City Retumns
All Estimates
All Extensions

* Selected Federal C Corp

* Selected States

* Selecled Cities

File Name

2016_Morgan Corp. RESET

CREATE

Figure 11:2
4. Enterthe File Name.
5. Select Create.

Create populates the History. This History area shows the file name, print status, print selection, start date
and time, and end date and time.

Once the print process has completed, you will see three options in the Actions column:
« Click Open to open the print file in PDF format within a separate browser window.
« Click Download to save the PDF to a desired location.

« Click Delete to delete the print file.
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Chapter 11: Printing the Return 110

Print Options

Print Preview provides an on-screen view of a return and all associated forms, schedules, and supporting

documents.

Bookmarks Collapse All F]

Search resuls: 0
- @ 120 )
~ @ MRepots
] Diagnostic Report
@ [ Estimated Values Summary
@ [1Override Summary Report
v & MFederal
[ Form 1120, Page 1
[ Form 1120, Page 2
[ Form 1120, Page 3

[ Form 1120, Page 4

R EJEQ

[ Form 1120, Page 5

3]

[ Form 4626

[JACE Worksheet

[ 5ch M-3, Page 2

[1Sch M-3, Page 3

[11118 Sch. A - Passive Categ
[11118 Sch B Foreign Tax Cre

[11118 Sch. A - General Categ

SIS YR U I

[ 1118 Sch B Foreign Tax Cre

&

v
[] 1118 Sch | Reduction For Oi
>

<
20 of 20 Pages Selected

BE 1 Go

Page10f20

4= Back PDF PREVIEW - COO2UEN6_RK FTC US PARENT. pdf O Refresh @ zoom Out @ Ft100% @ Zoomin

Diagrostic Report

Tax Year
Taxpayer: RK FIC US PARENT
1080

Severe Diagnostics : Total 3
Federal (3)

1.Tax Summary

Schedule M-3 and Page 1 are out of balance.

2.7ax 8

ReturnNo: 002UZI

usmary
Schedule L and Schedule M-2 retained earnings are out of balance.

3.Schedule ¥-1/4-3

¥et income per books on schedule M-1 does not agree with the et income

per books on schedule k-3,

Informaticnal Diagnostics: Total 2
Federal (2)

4.Form 1120/1120-C, Page 1

Erployer identification nusber is missing.

s.Form 1120/1120-C, Seh K
Business activity code number is missing.

#% No Electronic Filing Alerts Detected **

Electronic Filing - Rejects: Total 1
Federal (1)
6.Filer Foreign Address

Based on State Code entered in Organizer\General Information\Basic Return

Data\Entity Information, Forsign Address is applical
required entry. (Automatic GOTO not available).
1

. Foreign Country

Foreign Address :
Data\Entity Information.
Domestic Address : 1

Return

Figure 11:3

Return

PRINT OPTIONS

There are three places to go to review print options:

o Return and Print Options
o 1120-L Options

o 1120-PC Options
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Print Options

Return and Print Options
Navigation: Organizer > General Information > Return and Print Options > Basic Options tab
Where to go for control whether to print:

o Number of copies, return number, date and other information at the bottom of each page

NUMBER OF COPIES

Total number of federal returns to be printed.......

Total number of state returns to be printed ...

EVERY PAGE FRINT OPTIONS

Corparation Name and Federal EIN............... ... & Print O Suppress

Locator number and Account number... )
® Print ) Suppress

WIBIPSION MUMIBET. ..ot ® Print O Suppress

DA e ® Print © Suppress

=TSSR U S OU U SR SSIS RSOt ® Print O Suppress

Page NUMDBEL. ... ® Print O Suppress

Client Code. e ® Print ) Suppress

Figure 11:4
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Print Options

« Workpapers with the tax return and other documents

ATTACHMENTS

Statement number printing on the forms...........

'® Print ' Suppress
Entire "See Statement” text printing en the forms......... o Print O Suppress
All white paper statements with the tax return.......... o Pt O S

* Prin ' Suppress
Statement numbers printing on the white paper statements................... g Pt © Suppress
Selected federal forms attached tothe state returns. . o —

* Print - Suppress

NON-TAX FORM OPTIONS

Print Tax returm cover shest. e )
) Print  '® Suppress

Listing of DIagnostics ...

'® Print ' Suppress
Override Summary Sheet.. ... ® Print © Suppress
Estimate Summiary Sheet. ... ® Print © Suppress

Index of the Federal forms in the return......... .. O Print  ® Suppress

Schedule detailing carmyovers 1o NexXt year. ... Pt © Suppress

RETURN MAILING SHEETS

) Print return cover sheets for mailing
) Suppress print of taxpayer return cover sheet
) Suppress print of federal return cover sheet

) Suppress print of state return cover sheets

Figure 11:5
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Print Options

Some of the options that can be selected for printing are:

Include or omit return-specific information at the bottom of each page

Print workpapers with the return

Printreturn as an 1120-L, even if the percent-of-reserves test is not met

Include Loss Reserve Discounting and Salvage and Subrogation workpapers with the return
Force printreturn even if out of balance

M-3 print options

Suppress print of M-1 and M-2

Print LRD Workpapers

Print Annual Statement pages

If the return does not print as expected, always check the Return and Print Options screen. An option might
exist to change the appearance of the printed return.

Use Print Preview to check the appearance of the return before sending the return to the printer.

THOMSON REUTERS
1120 INSURANCE GUIDE



Chapter 11: Printing the Return 114
Print Options

Compute/Print Options for Schedule M-1/M-3

To change compute/print options for the Schedule M-1 or M-3:

1. Select Organizer > General Information > Return and Print Options > Tax Form Options tab.

Basic Options Pg 1-6 Options Tax Form Options E-file Options Accrual Options

SCHEDULE D

! Carry Capital Loss to Page 1 (Applies to taxable entity types only, i.e Single or Top Consolidated)

) Automatically prorate capital gaing and losses under Section 582

SCHEDULE M-1

) Print Schedule M-1 when the Schedule M-3 is used

SCHEDULE M-3

Schedule M-3 Options \

Figure 11:6

2. Selectthe Schedule M-3 Options link.

3. The Compute Options section gives you computation choices for Schedule M-1 and M-3. The default is
calculation of both Schedule M-1 and M-3.

D/‘ Schedule M-1 will not print if M-3 is completed unless you select the option to force print
- Schedule M-1 from the Print Options section.

4. Use the Print Options section to suppress Schedule M-3 or force print Schedule M-1 when M-3 is
completed.
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Print Options

Reviewing Print Options

Check the print options before printing a return. By default, the system does not print out-of-balance returns. If
your return is not printing, make sure the Allow printing of the tax return even if it is out-of-balance
option is selected. If your return is not printing the way you expect, check your print options that include:

Printing an out-of-balance return

Suppressing information at the bottom of each page

o Attachments
o Number of copies
¢« Non-Taxforms

State suppression

Workpapers display supporting detail for the numbers appearing on a return. Be sure to provide an audit trail
from the Tax Form to the Organizer. Workpapers can be printed separately or with the tax return.
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